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 مقدمة:

مقياس تطبيقي يهدف إلى تزويد الطالب بالمهارات العملية اللازمة   الإحصائية  برمجياتمقياس  
لتحليل البيانات الاقتصادية والاجتماعية باستخدام أحد أشهر الحزم الإحصائية الموجهة لدراسة 

 . EViewsالسلاسل الزمنية والبيانات المقطعية، وهو برنامج 
  والاقتصاد  للإحصاء  النظري   الجانب  بين  الربطيهدف هذا المقياس بشكل أساسي إلى  لذا   

 ، وذلك بتمكين الطالب من: التطبيقي والجانب القياسي
 المفاهيم والنماذج الإحصائية والاقتصادية القياسية التي تم دراستها نظريا.  تطبيق •
 البيانات وتحليلها بشكل فعال وسريع.  معالجة •
 النتائج الإحصائية بشكل دقيق وموثوق.  استخلاص •
 المخرجات الإحصائية بما يخدم اتخاذ القرارات أو صياغة التوصيات العلمية.  تفسير •

يمثل   أنه  في  للطلاب  المقياس  هذا  دراسة  أهمية    العلمي   البحث  نحو   العبور   جسر تكمن 
اقتصاد  ، حيث يزودهم بالأداة القوية التي يحتاجها الباحث في مختلف التخصصات )التطبيقي

التخصصات المالية وغيرها من  المحاسبةـ،  والمالي،  النقدي  الاقتصاد  المؤسسات،  (  وتسيير 
لإجراء دراسات معمقة، وتحليل البيانات المعقدة، والتحقق من صحة الفرضيات، مما يعزز من  

 قدراتهم التحليلية ويؤهلهم لسوق العمل الذي يتطلب مهارات متقدمة في تحليل البيانات. 
سوف نتناول في هذا المقياس رحلة متكاملة للتعامل مع البيانات الإحصائية والاقتصادية       

 ، حيث يتمحور البرنامج حول النقاط الأساسية التالية: EViewsالقياسية باستخدام برنامج 
ومكوناته    :EViews  برمجية   تقديم  أولا: ▪ مميزاته،  البرنامج،  واجهة  على  التعرف 

 الأساسية.
على    (:Workfile)  عمل   ملف   إنشاء   ثانيا: ▪ سيحتوي  الذي  الملف  بناء  كيفية  تعلم 

 البيانات والمتغيرات اللازمة للتحليل. 
إتقان طرق إدخال البيانات المختلفة )يدويا،    :EViews  برنامج  في  بيانات  إدخال  ثالثاً: ▪

 (.Excelأو استيرادها من مصادر خارجية مثل 



 مقياس برمجيات احصائية  
 

 2 

استكشاف    للمتغيرات:   الإحصائية   الخصائص  وحساب  البيانية   الأشكال   رسم   رابعا:  ▪
المقاييس الإحصائية الوصفية الأساسية   البيانية، وحساب  البيانات من خلال الرسوم 

 )الوسط، الانحراف المعياري، إلخ(. 
يدرس    البسيط:  الخطي  الانحدار  خامسا:  ▪ الذي  الانحدار  لنموذج  العملي  التطبيق 

 العلاقة بين متغير تابع ومتغير مستقل واحد. 
متغير    المتعدد:  الخطي  الانحدار  نموذج  سادسا: ▪ من  أكثر  ليشمل  النموذج  توسيع 

 مستقل، وتقدير النموذج وتفسير نتائجه. 
إجراء    :(Autocorrelation)  للأخطاء   الذاتي   الارتباط  سابعا:  ▪ المشكلة،  تعريف 

 (، وطرق معالجتها إحصائيا. Durbin-Watsonاختبارات الكشف عنها )مثل اختبار 
تعريف الظاهرة، تطبيقات اختبارات    :(Heteroscedasticity)  التباين  إختلاف  ثامنا: ▪

 (، والحلول المقترحة لهذه المشكلة. Whiteالكشف عنها )مثل اختبار 
مفهوم    :(Multicollinearity)  الخطي  التداخل(  الاشتراك،  )الازدواج،  التعدد  تاسعا: ▪

 . ومعالجته التعدد الخطي، أدوات الكشف عنه )مثل معاملات الارتباط(، 
السلاسل   الفصلية:   نزع  طرق   الفصلية،   المركبة   عن  الكشف   عاشرا:  ▪ مع  التعامل 

للحصول   المركبة  إزالة هذه  تحتوي على مكون موسمي، وتطبيق طرق  التي  الزمنية 
 على بيانات معدلة موسميا. 
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 Eviewsتقديم برمجية -أولا

البرامج برامج التحليل الإحصائي للبيانات هذا من جهة، ومن جهة ثانية يعد من  أحد    Eviewsيعتبر برنامج     
أو اختبار   وتقدير ودراسة النماذج الاقتصاديةإجراء التحليل القياسي    في كثيرا في الآونة الأخيرة  المتقدمة والمستخدمة  

والتنبؤ بمتغيرات الاقتصادية الكلية،   النماذج   تحليل البيانات، تقديرباجراء    لأنه يسمح،  النظرية الاقتصادية بصفة عامة
اختبار التكامل المشترك ،  (Unit roots tests)المحاكاة، اختبار استقرارية السلاسل الزمنية أو اختبار جذور الوحدة  

(Cointegration tests)  ،  تقدير نماذج بيانات بانل(Panel data)  ، بالاظافة إلى تقدير النماذج الساكنة والنماذج
الذاتي الانحدار  النماذج....الخ. الدينامكية كنموذج  من  اسراتيجياتهم    وغيرها  تنفيذ  القرار  لمتخذي  تسمح  والتي 

 المستقبلية سواءا تعلق الأمر على المستوى الاقتصاد الكلي للدولة أو الاقتصاد الجزئي على مستوى المؤسسات. 

 Eviews   في برنامج ماهية  -1
يعد نسخة جديدة من الحزم الاحصائية لمعالجة بيانات السلاسل الزمنية وفي الأصل تم تطويرها   Eviews   رنامج ب   

الزمنية   السلاسل  معالجة  برنامج  الكبيرة.    Time Series Processor (TSP)من   يعدلأجهزة كمبيوتر 
Eviews   .يوفر مجموعة واسعة من الميزات   إذ   برنامج إحصائي قوي مصمم لتحليل البيانات الاقتصادية والمالية

، قطعيةتحليل البيانات الم،  تحليل السلاسل الزمنية  كتحليلالتي تسمح للمستخدمين بإجراء تحليلات إحصائية معقدة،  
 . ....الخ  تحليل البيانات المالية و   تحليل النماذج الاقتصادية 

يستخدم ،  أي اظهار أواستعراض الاقتصاد القياسي  Econometric viewsهي اختصار لـــ    Eviewsكلمة       
في الأبحاث الاقتصادية والتحليلات الإحصائية. يتم استخدامه بشكل رئيسي في الجامعات   Eviews   برنامج

البيانات الاقتصادية وإجراء الاختبارات الإحصائية والتنبؤات الاقتصادية البحثية والشركات لتحليل      .والمؤسسات 
للمستخدمين استيراد وتحليل البيانات الاقتصادية وإجراء التحليل الإحصائي عليها. يحتوي   Eviews   برنامجيتيح  

 . على واجهة سهلة الاستخدام تسمح للمستخدمين بإجراء العديد من العمليات الإحصائية المختلفة
العديد من الأدوات والوظائف للتحليل الإحصائي والاقتصادي، مثل الانحدار   ا يوفر أيضEviews   برنامج     

الخطي، والتحليل العاملي، والتحليل المتعدد المعادلات، وتحليل سلاسل الزمن، والتكامل المشترك، وغيرها من الأدوات 
 .الإحصائية

برنامج -2 برنامج  :Eviews   ميزات  لتحليل  Eviews يوفر  قوية  أداة  التي تجعله  الميزات  مجموعة واسعة من 
 :البيانات الاقتصادية والمالية. تشمل بعض الميزات الرئيسية ما يلي
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بواجهة مستخدم رسومية سهلة الاستخدام  Eviews يتميز  :واجهة مستخدم رسومية سهلة الاستخدام  •
 .تجعل من السهل على المستخدمين إنشاء نماذج وتحليل البيانات

مجموعة واسعة من أنواع البيانات، بما في ذلك البيانات  Eviews يدعم :دعم مجموعة واسعة من البيانات •
 .الزمنية والبيانات القطعية والبيانات المالية

مجموعة واسعة من الميزات الإحصائية التي تسمح  Eviews يوفر :مجموعة واسعة من الميزات الإحصائية •
 .للمستخدمين بإجراء تحليلات إحصائية معقدة

مجموعة متنوعة من أدوات النمذجة التي تسمح للمستخدمين ببناء  Eviews يوفر :أدوات نمذجة قوية •
 .نماذج اقتصادية ومالية

على نطاق واسع من قبل الباحثين والأكاديميين  Eviews يستخدم برنامج :Eviews  استخدامات برنامج-3
 :ما يلي Eviews والممارسين في مجال الاقتصاد والمالية. تشمل بعض الاستخدامات الشائعة لبرنامج

 .تحليل السلاسل الزمنية •
 ها. وتقدير   تحليل النماذج الاقتصادية  •
 .تحليل البيانات المالية مثل أسعار الأسهم والسندات •
 .تحليل المعادلات المتعددة وتقدير المعاملات المرتبطة بينها •
العديد من الاختبارات الإحصائية المتاحة لتحليل  EViews إجراء الاختبارات الإحصائية: يتضمن •

البيانات الاقتصادية. يمكنك إجراء اختبارات الفرضية، مثل اختبار الفرضية المشتركة واختبار التسلسل 
 .الزمني واختبارات الأخطاء العشوائية وغيرها

 النافذة الرئيسية للبرنامج: -4
 تتكون النافذة الرئيسية  ك في البرنامج  هي المكان الذي تبدأ منه جميع عمليات EViews لنافذة الرئيسية لبرنامجا   
 على العناصر الأساسية التالية:   EViewsنامج  لبر 
  EViewsالقائمة الرئيسية هي القائمة التي تظهر عند فتح برنامج  : Main menuالقائمة الرئيسية -4-1

 هي: تحتوي على مجموعة متنوعة من الخيارات  
File, Edit, Object, View, Proc, Quick, Options, Add-ins, Windows, Help 

 : لي شرح لبعض منهاي وفيما  
 تحتوي هذه القائمة على خيارات لفتح الملفات وحفظها وتصديرها وطباعة التقارير.   :File  ملف ▪
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 تحتوي هذه القائمة على خيارات لتحرير البيانات والنماذج والرسوم البيانية.  :Edit  تعديل ▪
 تحتوي هذه القائمة على خيارات لإنشاء المتغيرات وتحريرها وإدارتها.   :Object  متغيرات ▪
 تحتوي هذه القائمة على خيارات لتغيير طريقة عرض البيانات والنماذج والرسوم البيانية.  :View  عرض ▪
 تحتوي هذه القائمة على خيارات لإنشاء النوافذ وإدارة النوافذ المفتوحة.  :Windows  نوافذ  ▪
 تحتوي هذه القائمة على خيارات للوصول إلى المساعدة والدعم.  :Help  مساعدة ▪

الأوامر  -4-2 برنامج  :  Command windowنافذة  في  الأوامر  يمكن   EViewsنافذة  مهمة  أداة  هي 
 . تحرير البيانات،  عرض الرسوم البيانية،  إنشاء النماذج،  فتح الملفاتكاستخدامها لتنفيذ مجموعة واسعة من الأوامر،  

هذه المساحة تظهر جميع الملفات التي تم انشاءها وهي بمثابة مكتب به جل :  Work area  مساحة العمل -4-3
 الاوراق المستخدمة في العمل. 

يحتوي شريط العنوان على اسم الملف الحالي الذي يعمل عليه المستخدم. يمكن :  Titre Bar  شريط العنوان-4-4
 .للمستخدم تغيير اسم الملف بالنقر فوق شريط العنوان وتحرير الاسم

 بالنقر مرتين على برنامج المثبت على سطح مكتب جهازك تظهر الشاشة التالية:     
 EViews  النافذة الرئيسية لبرنامج 

 

 : الخيارات في القائمة الرئيسية  لبعضفيما يلي شرح موجز  

 شريط العنوان
Titre Bar 

 منطقة العمل 
Work area 

 نافذة الأوامر 
Command 

window 
 القائمة الرئيسية 
Main menu 

 إحالة السطر 
Status line 
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 File  ملف 
 تستخدم لإنشاء ملف جديد.  :File New  جديد  ملف  إنشاء •
 تستخدم لفتح ملف موجود.   :Open  فتح •
 تستخدم لحفظ ملف حالي.   :Save  حفظ  •
 دير ملف حالي إلى تنسيق آخر. ـتستخدم لتص  :Export  تصدير •
 تستخدم لطباعة ملف حالي.   :Print  طباعة  •
 تستخدم لإغلاق ملف حالي.   :Close  إغلاق •
 تعرض قائمة بأحدث الملفات التي تم فتحها.   :Files Recent  الملفات   أحدث •
 تيراد بيانات أو محتوى من ملف آخر.ـتستخدم لاس  :Import  استيراد •
 دير بيانات أو محتوى إلى ملف آخر.ـتستخدم لتص  :Export  تصدير •
 تستخدم لطباعة بيانات أو محتوى.   :Print  طباعة  •

 
 

 Edit  تعديل 
 . (المحتوى من مكان إلى آخر)خدم لقص البيانات  ـتست  :Cut  قص •
 . (المحتوى من مكان إلى آخر)خدم لنسخ البيانات  ـتست  :Copy  نسخ •
 . (المحتوى من مكان إلى آخر)خدم للصق البيانات  ـتست  :Paste  لصق •
 خدم لحذف البيانات أو المحتوى.ـتست :Delete  حذف  •
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 ثور على بيانات أو محتوى معين. ـتستخدم للع  :Find  بحث  •
 خدم لاستبدال بيانات أو محتوى معين ببيانات أو محتوى آخر. ـتست  :Replace  استبدال •
 ع عن إجراء سابق.ـتستخدم للتراج  :Undo  التراجع  •
 راء سابق تم التراجع عنه.ـتستخدم لإعادة تنفيذ إج  :Redo  الإجراء  إعادة  •
واستبداله    :Replace and Find  والاستبدال  البحث • معين  محتوى  أو  بيانات  على  للعثور  تستخدم 

 ببيانات أو محتوى آخر. 
 ا للبحث عن البيانات أو المحتوى. ـتوفر خيارات أكثر تقدم  :Find Advanced  المتقدم   البحث •

 Object  متغيرات  
 تستخدم لإنشاء متغير جديد.   :Create  إنشاء •
 تستخدم لتحرير متغير موجود.  :Edit  تحرير •
 تستخدم لحذف متغير موجود.   :Delete حذف •
 تستخدم لعرض خصائص متغير موجود.   :Properties  الخصائص •
 تعرض قائمة بالمتغيرات الموجودة.   :Variables View  المتغيرات  عرض •
 تعرض البيانات الخاصة بمتغير موجود.   :Data  البيانات •
 تعرض النموذج الخاص بمتغير موجود.   :Model  النموذج •
 تعرض الرسم البيان الخاص بمتغير موجود.   :Chart  البيان   المخطط •

 View  عرض 
 تستخدم لعرض البيانات أو المحتوى في شكل رسم بيان.   :Chart  البيان  الرسم •
 تستخدم لعرض البيانات أو المحتوى في شكل جدول.   :Table  الجدول •
 تستخدم لعرض البيانات أو المحتوى في شكل مخطط زمني.  :series Time  الزمني   المخطط •
 تستخدم لعرض البيانات أو المحتوى في شكل جدول زمني.   : etabl Time  الزمني   الجدول •
 تتيح للمستخدم تخصيص طريقة عرض البيانات أو المحتوى.  :Preferences  الإعدادات •

 

 

 



 مقياس برمجيات احصائية  
 

 8 

 

 Work file  إنشاء ملف عمل -ثانيا

ه، من أولى الخطوات التي يمكن القيام بها عند التعامل مع   Eviews جديد في برنامجعمل  تعتبر عملية إنشاء ملف    
 بطريقتين:   ويتم ذلك
ثم    Newثم بند    Fileتار قائمة  نخثم    Main menuالرئيسية  إلى  بعد فتح البرنامج بالذهاب القائمة   ▪

 . Work file الأمر  
 في لوحة المفاتيح مباشرة بعد فتح برنامج، ويظهر ذلك أدناه:  Ctrl+Nبالضغط مباشرة على الزرين   ▪

File/ New/ Work File 
 كما يظهر أدناه: 

 
 
 
 
 
 
 
 

 في حالة التي يكون فيها قد تم إنشاء ملف عمل في السابق فلفتحه يتبع الخطوات التالية:  ملاحظة:
File/ Open/ Eviews Wokfile 

: كما يظهر أدناه  
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 يظهر لنا ما يلي:  Work file الأمر  وبعد النقر على  

 
 

 : ويظهر لنا أنه لانشاء ملف لابد من  
نجد   كما هو مبين أدناه  Wokfile Structure Typeبالنقر على الأمر    : تحديد نوع البيانات المستخدمة-1

 :ثلاثة أنواع
▪ Unstructured/Undated 
▪ Dated-regular frequency 
▪ Balanced Panel 

▪ Unstructured/Undated : إذا كانت البيانات عبارة عن مشاهدات بدون تاريخ مثلا بيانات عن
  .دول  10  ل ـــناتج محلي إجمالي لعينة 

▪ Dated-regular frequency  :  عبارة عن سلاسل زمنية مثلا قد تكون يومية إذا كانت البيانات
- 1990شهرية أو نصف سنوية أو سنوية كتطور ناتج المحلي إجمالي للجزائر خلال الفترة    أو أسبوعية  أو  

2020. 
▪ Balanced Panel:   المضافة لمجموعة من كتطور القيمة  عبارة عن بيانات بانل مثلا  إذا كانت البيانات

  2000خلال الفترة    للجزائر، تونس والمغربتطور الناتج  المؤسسات الاقتصادية خلال فترة زمنية معينة، أو  

ويظهر    وهي عبارة عن دمج بين النوعين السابقين )البيانات المقطعية وبيانات السلاسل الزمنية(  2023إلى  
 : ذلك كما يلي
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 : كما يليحالة مما سبق  شرح لكل  ويتم  

تاريخ  -2 بدون  مشاهدات  عن  عبارة  تسمى    (Unstructured/Undated)بيانات  بالبيانات أيضا  : 
  Wokfile Structure Typeمن خانة    Unstructured/Undatedفبعد فتح ملف جديد نختار  المقطعية  

لتحديد مدى المشاهدات  ليكن   Data rangeمن    Observationوندخل رقم المشاهدات التي بحوزتنا في خانة  
 مشاهدة مثلا:  30لدينا  

Wokfile Structure Type/ Unstructured/Undated/ Data range/ Observation 

 

حصل تن  okبالضغط على    work01ولنقم بتسميته بــــ   Workfile namesكما ندخل اسم الملف في خانة     
 على ما يلي: 
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هنا نميز إذا كانت سنوية، ربع سنوية، شهرية، أسبوعية أو يومية  :(Dated)بيانات عبارة عن سلاسل زمنية -3
 كما يلي: 

ثم الذهاب   Date specification  فنذهب إلى الأمر  :(Annual)  بالنسبة لإدخال البيانات السنوية-1- 2

Frequency   ثم نختار    وبعدها الضغط علىAnnual كما يظهر أدناه : 

Date specification/ Frequency/ Annual 

 
 يظهر لنا ما يلي:  Annualالأمر  بالضغط على  
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 Endوسنة التي تنتهي فيها في خانة    Start dateد ذلك نمر إلى كتابة السنة التي تبدأ منها البيانات في خانة  بع    

date  ،نكتب كما يلي:  2010- 1990بيانات خلال الفترة  لدينا  كن  تل 

Annual : Star date : 1990    End date : 1995   

 

يمكن كتابتها على هيئة رقمين على البيانات المجمعة    إذا كانت  وللإشارة هنا فقط لغرض الاختصار في الكتابة   
كما في على هيئة عدد مكون من أربعة أرقام    ا أو يتم إدخاله  2000  -1990اختصارا لــ    90-00سبيل المثال  

   السابق.

في   Quarterlyاختيار  في حالة البيانات الربع سنوية بعد    :(Quarterly)  ربع سنويةإدخال البيانات  - 2- 2

 كما يظهر أدناه:   بعد الضغط على  Frequency  من خلال خيارات  Date specification  الأمر
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Date specification/ Frequency/ Quarterly 

 

، ولتوضيح السنةربع  رقم  ثم كتابة    (.)  نقطةأو    (:)  نقطتين رأسيتين أو    (,)  فاصلةال  كتابةثم    السنة نقوم بكتابة  
 1995لسنة    الربع الثالثإلى غاية    1990لسنة    الربع الثانيانطلاقا من    ربع سنويةذلك نفترض أنه لدينا بيانات  

 فنكتب:

 Quarterly : Star date : 1990,2    End date : 1995,3   

 

 : بدل الفاصلة  السنة بعد    رأسيتين ال  النقطتين   بكتابةأو  

 Quarterly : Star date : 1990 :2    End date : 1995 :3    
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 : كما يلي  بعد السنة  ).(   النقطةأو بكتابة  

 Quarterly: Star date : 1990.2    End date : 1995.3    

 

 . لتأكيد الاختيار (OK)وبعد ذلك نقوم بالنقر على الأمر  

  Date specification  الأمرفي    Monthlyاختيار  بعد    :(Monthly)  إدخال البيانات الشهرية- 3- 2

 كما يظهر أدناه:   بالضغط على   Frequency  من خلال خيارات

Date specification/ Frequency/ Monthly 
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في خانتي بداية   رقم الشهركتابة  ثم    نقطتين رأسيتينأو    فاصلة أو    نقطة   كتابة ثم    السنةبكتابة  بعد ذلك نقوم      
 نكتب كما يلي: 2010إلى نوفمبر    1990بيانات من شهر مارس  فعلى سبيل المثال ونهاية تأريخ  

Monthly : Star date : 1990,2    End date : 1995,3    

 

من خلال   Date specificationفي الأمر    Weeklyاختيار  بعد    (Weekly)الأسبوعية  في حالة البيانات    2
نقوم بكتابة  الاسبوع ثم الشهر ثم السنة ويفصل بين كل منهم بنقطة ).( أو نقطتين ):(   Frequencyخيارات 
 1995إلى غاية الاسبوع الثالث من شهر ديسمبر  1990الاسبوع الثان لشهر مارس مثلا بيانات من    كما يلي 

 : فإننا نكتب ذلك كما يلي

Date specification/ Frequency/ Weekly 

Star date : 1 : 3 : 1990    End date : 3 : 12 : 1995 
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   :(Daily)  إدخال البيانات اليومية- 4- 2

 

الأما   البيانات  حالة  خيارات   Date specification  الأمرفي    Dailyاختيار  بعد    ية يومفي  خلال   من 
Frequency   :كما يلي 

Date specification/ Frequency/ Daily 

 

على أساس أن   Daily-7 day weekبدل من    Daily-5 day weekهنا للإشارة فقط يمكن اختيار      
تكتب بترتيب  وهنا يبقى الخيار للباحث وفقا لنوعية البيانات التي بحوزته.  أيام الأسبوع خمسة أيام بدلا من سبعة أيام

ثم كتابة   اليومأو    تاريخ مصادف لرقم أسبوعثم كتابة    (/)ثم كتابة    رقم الشهر معاكس لما سبق إذ نقوم بكتابة  
 كما يلي:  السنةثم كتابة    (/)

نكتب كما يام (  أ  7ساس الاسبوع به  أ)على     1995من سنة    31/11إلى    1990سنة      03/ 01  منمثلا بيانات    
 يلي:
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Weekly: Star date : 3/1/90    End date : 11/31/95  

 ويظهر ذلك كالتالي:  

 

المنشأ ويكون غير مسمى ملف العمل    يظهرف ok على أيقونةبعد الانتهاء من تحديد نوع البيانات نقوم بالضغط      
Untitled   ،كون يحتوي على أيقونتينوالذي يلعدم تخزينه بعد: 

 التي يتم تقديرها فيما بعد.   Cشعاع معاملات     ➢
 .   Residشعاع البواقي   ➢

 : 2000-1990كما يتبن أدناه مثلا في حالة بيانات سنوية خلال الفترة  

 
 تأتي مرحلة إدخال البيانات الإحصائية. Work fileإنشاء ملف العمل    مرحلة   بعد الانتهاء من 
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 Eviewsفي برنامج  إدخال بيانات -لثاثا

 هما:  Eviewsهناك طريقين لإدخال بيانات في برنامج    
لإدخال البيانات يدويا لابد أن يكون لديك ملف عمل تم إنشاءه حسب البيانات إدخال البيانات يدويا:  -1

 ولاوضيح هذا نأخذ المثال التالي:  ريد إدخالهانالتي  
للجزائر خلال   TM2والكتلة النقدية    GDPهما ناتج المحلي الخام    ينبيانات سنوية لمتغير لتكن لدينا    :01مثال  
 كما يلي: 2023-2000الفترة  

T 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 

GDP 2,355 1,592 3,988 5,067 3,040 3,972 1,428 1,435 0,763 -0,601 2,870 1,063 

TM2 0,010 0,502 0,144 0,197 0,186 0,098 0,207 0,290 0,245 -0,068 0,109 0,223 

T 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 

GDP 
0,429 0,602 2,060 1,157 1,849 -0,467 -0,512 -0,939 -6,632 2,093 1,927 2,495 

TM2 
0,044 0,059 0,127 -0,197 -0,072 0,069 0,057 -0,031 0,012 0,062 0,087 0,108 

 
 نذهب إلى: 

File/New/Workfile 

 ونذهب إلى:   okوبالنقر على  

Date specification/ Frequency/ Annual 

Annual: Star date : 00    End date : 10    

 ويظهر لنا ما يلي:
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 نذهب إلى:   Workfileمن القائمة الرئيسية أو من قائمة ملف العمل -

Object/New object 

 
 نختار نوع السلسلة:  يظهر لنا ما يلي:  Okبالضغط على  -

Types of object/Series 
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 يظهر لنا ما يلي: Okبالضغط على     GDPوادخال اسم المتغير هنا   Seriesباختيار  -

 
كما  TM2و  GDPويتبن لنا أنه قد تم تكوين السلسلتين    TM2  الثانية  نعيد العملية بالنسبة لإدخال السلسلة -

 يلي:

 
كتابة  و   -/+Editمن خلال فتح السلسلتين السابقتين بالضغط عليها مرتين نقوم بإدخال البيانات بالضغط على  -

  :وكتابة قيمة السلسلة في السنة المواليةمن لوحة المفاتيح   ENTER  قيمة السلسلة وبالضغط في كل مرة على:
 يتبين لنا ما يلي: بعد الانتهاء من كتابة كل قيم السلسلة  -
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 : Workfileمن خلال شريط القوائم لملف العمل إدخال البيانات  -2  

  Workfileالعمل كما يمكن تكوين السلسلتين وإدخال البيانات بطريقة أخرى من خلال شريط القوائم لملف     
 بإتباع الخطوات التالية:

Quick/Empty Group(Edit Series) 

 
 إسم السلسلة كما يظهر أدناه:   ندخل nameلضغط على  با  -
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 نتحصل على ما يلي:   Okوبالضغط على  -

 
مع تسمية كل سلسلة ونتحصل   بنفس الطريقة السابقة سلسلة تلوى الأخرىوندخل بيانات قيم السلاسل المتبقية    -

 على ما يلي: 
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كما يمكن اختصار كل ذلك من خلال كتابة الأمر التالي في مساحة الاوامر وذلك من خلال منطقة الأوامر:  -3
 نكتب في نافذة الأوامر:  Workfileبعد تكوين ملف  
 : نكتب الأمر  في حالة إدخال بيانات سلسلة واحدة  ➢

Series M2  

 
 يلي: ما  نجد أن البرنامج قد قام بانشاء السلسة الجديدة ك   من لوحة المفاتيح ENTERبالنقر على  -

 
متبوعة باسم    Dataكلمة    في حالة إدخال بيانات سلسلتين فأكثر نكتب في منطقة الأوامر ➢

 : كما يلي  )مع ترك فراع بين الاسمين(    السلسلتين  
Data GDP M2 
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قيم يتم إدخال    ذلك   بعد و نجد أن البرنامج قد قام بانشاء السلسلتين     من لوحة المفاتيح ENTERبالنقر على  -
 .المتغيرات بنفس الطريقة السابقة

 لتوضيح ذلك نأخذ المثال التالي:   :كيفية ادخال بيانات مقطعية-
 X1  أفراد العائلة وعدد  Yلتيكن لدينا المعطيات التالية لعينة مكونة من ثمانية افراد بها دخل الفرد    :02مثال  -

 . X3وعدد سنوات التعليم    X2= أنثى( 2= ذكر،  1والجنس )
 الفرد 

 المتغير

1 2 3 4 5 6 7 8 

Y 50 65 55 90 100 120 78 125 

X1 4 5 9 1 3 6 3 2 

X2 1 0 1 1 0 1 0 1 

X3 10 8 5 8 9 12 4 11 

 نقوم بفتح ملف كما يلي:  الحل:
File→New→Workfile 

 

 ثم نحدد نوع البيانات كما يلي:-

Wokfile Structure Type→ Unstructured ∕ Undated 

 بالذهاب إلى:   (8كتب حجم العينة )حسب مثالنا الرقم  ثم ن-

Data range→ Observation 

 يظهر مما يلي: workfile 24نقوم بكابة اسم الملف كذلك وليكن مثلا:  -
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 ما يلي:نجد   OKبالضغط على  -

 
 

 كما يلي :   المتغيراتمتبوعة باسم    Dataنكتب في منطقة الأوامر كلمة  -
Data Y X1 X2 X3 

 

 يظهر لنا ما يلي وبعد ذلك ندخل قيم المتغيرات كما في السابق:-
 

 

 النافذة الموضحة أدناه: نتحصل على    من ادخال البيانات بعد الانتهاء-
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 لتوضيح ذلك ناخذ المثال التالي:   كيفية ادخال بيانات ثنائية )متغير وهمي(:   -
  2012حتى    1990نفترض أنه لدينا بيانات حول العوامل المؤثرة على حجم الناتج المحلي في الفترة من    :  03مثال    

 ومن بينها متغير يمثل الوضع الاقتصادي السائد بحث: 
D=1 :  إلى   2000ستقرار الاقتصادي والذي كان خلال الفترة من الربع الأول من سنة  لاا وجود  في حالة عدم

 2012الربع الرابع من سنة  
D=1 : إلى الربع الرابع من  1990الاستقرار الاقتصادي والذي كان خلال الفترة من الربع الأول من سنة    في حالة
 1999سنة  

 يتم ذلك كما يلي: 
 2012إلى نهاية سنة    1990بعد انشاء ملف عمل لبيانات ربع سنوية )فصلية( من بداية سنة  

 
 
دلالة   NAأما باقي الفترة فيأخذ  ،  Q42012حتى    Q12000للفترة    1سيتم اعطاء القيمة    okبالضغط على    

 على عدم تعريف ذلك المدى 
 نكتب ما يلي:   Q41999حتى   Q11990للفترة    0لإعطاء القيمة  
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D2000=0 :  أسفلenter equation   حيثD2000 

 Q41999حتى    Q11990ليصبح    Sampleيمثل اسم المتغير اذ لا يمكن تغييره وبعد ذلك نقوم بتغيير مدى أسفل  

 

   لتنفيذ ذلك نتبع الخطوات التالية:  :Excelاسترداد البيانات من برنامج    -4
File /open /Foreign data as workfile 

 
 كما يلي:    نوعية الملفزينه في الحاسوب مع تحديد  نبحث عن اسم الملف في مكان تخ-

Ovrir /Excel 



 مقياس برمجيات احصائية  
 

 28 

 
ثانية يظهر لنا   Ovrir( وبالضغط على  gdp m2هو    اسم الملفبالضغط على اسم الملف مثلا هنا في مثالنا )-

 ما يلي: 

 
 بالضغط على: -

  Suivant / Suivant/ Suivant /Finish 

 نتحصل على: 
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المحفوظة لدينا، ونقوم في المرحلة الموالية بفحصها   Excelleوبذلك نكون قد انتهينا من استيراد البيانات  -
 . الخصائص الاحصائية لها  حسابو  عليهاوالتحويلات  وإجراء مختلف العمليات  البيان    التحليلمن خلال ا

 
 

 وحساب الخصائص الاحصائية للمتغيرات  البياناتالأشكال  رسم    -رابعا
 
 نوجزها في:   هناك عدة طرق  Eviewsلرسم الأشكال البيانية في برنامج    

السلسلتين:     01المثال  باستخدام معطيات   بتظليل  القيم  السلسلتين بصحة  ثم    GDP M2نقوم بالتأكد من 
 وبالنقر على:   يسرى للفأرةنضغط على الجهة  

Open /as Group 

 
 وبعدها نلاحظ أنه تم فتح السلسلتين

 ا ثم نضغط على: هنحدد السلسلة ونقوم بفتح  :Viewالرسم من خلال  -1
View /Graph 
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 ما يلي:)الأعمدة البيانية مثلا(  Barوبعدها نختار الشكل المناسب مثلا نختار من القائمة  -

 
ولنسخ الشكل على صفحة في شكل أعمدة بيانية    GDPفيظهر لدينا شكل السلسلة    Okبالضغط على  -  

Word  ثم نذهب إلى  وسط الشكل في البرنامج   ليسرى للفأرة االجهة  لضغط على  نقوم باCopy to clipboard 

(Ctrl+C)  : 

 
 ويظهر الشكل أدناه:  Collerنذهب إلى مكان نسخ الرسم ونضغط على  -
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 : يلي  يتم ذلك كما   :Quick/Graphالرسم باستخدام    -2

 

 

 أدناه:  نتحصل على الشكل البيان  okوبعدها ندخل اسم المتغيرين ونختار نوع الشكل وبالضغط على     

 
 : رسم العلاقة الخطية بين متغيرين-3
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نقوم بتحديد المتغيرين TM2 و  DDPرسم العلاقة الخطية بين متغيرين  نقوم ب    01المثال  باستخدام معطيات       
كما يلي:  )بافتراض لدينا ملف عمل   as groupثم    openولا ثم نقوم بالضغط على يمين الفارة فتظهر لنا  أ

 (.  2023الى    2000من  للمتغيرين أهلاه لبيانات  
 ليل السلسليتن )مع الضغط على المتغير المستقل أولا( وبالضغط على الجهة اليسرى للفأرة ونذهب إلى: ظنقوم بت-

Open→ as group 

 نتحصل عل ما يلي: 

 
 ثم نتبع ما يلي: -

View→Graph→ Graph type→ Scatter  

 ونتحصل على ما يلي:   Regression Lineنختار    Fit linesثم من خلال  

 
 كل التالي: نتحصل على الش okبالضغط على   
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لحساب مختلف الخصائص الإحصائية للمتغيرات المدرجة في حساب الخصائص الإحصاء للمتغيرات:  -4

حسب مثالنا(  GDPمثلا لكل سلسلة على حدا نقوم بفتح السلسلة )مثلا هنا نقوم بفتح سلسلة  الدراسة  
 السابق ونذهب إلى: 

 : نذهب إلى: الحصول على الخصائص الإحصائية فقط- 1- 4

View /Descriptive Statistics & Tests / Stats Table 
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 نحصل على:   Okعلى    بالنقر

 
الإحصائية  - 2- 4 الخصائص  على  للسلسلةو الحصول  بياني  الإحصائية معا  شكل  البيانات  على  للحصول   :

 بالإضافة إلى شكل بيان يبين توزيع قيم السلسة نختار سلسلة ونذهب إلى: 

View /Descriptive Statistics & Tests /Histogram and Stats 

 
 نحصل على: Okوبالضغط على  
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 Copyثم نذهب إلى  ليسرى للفأرة وسط الشكل في البرنامج الجهة الضغط على  ولغرض نسخ المحتوى نقوم با-  

to clipboard (Ctrl+C)  كما في السابق . 
تظليل المتغيرات المعنية وبعد ذلك نقوم بفترحها )الضغط نقوم ب   لعدة متغيرات: لحساب الخصائص الإحصائية  -3- 4

 :تغيراتمن خلال القيام بتظليل الم  للولحة المفاتيح(  Enterأو بالنقر على زر    openعلى  
GDP TM2 INF 

 وبالنقر على:  يسرى للفأرةالجهة  نضغط على  ثم نضغط  
Open /as Group 

 ب إلى: ثم نذه
View /Descriptive Stats /Common Sample 

 

 

 لغرض التوضيح.  TM2و  GDP  للمتغيرينل INFضافة متغير التضخم  إتم   ملاحظة:
 ولغرض نسخ المحتوى نقوم بنفس الطرقة السابقة أو نذهب إلى: 
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Edit /Copy (Ctrl+c) 

 
 نحصل على: Collerوبالنقر في مكان نسخ المحتوى وبالنقر على  

 
 
 حساب التغاير، الارتباط بين المتغيرات: -5
لحساب التغاير بين سلسلتين أو أكثر نتبع الخطوات  :  Cov(GDP, M2)حساب التغاير بين السلسلتين  -1- 5

 التالية:

Quick /Group Statistics /Covariances 
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 بكتابة اسم السلاسل )هنا لدينا سلسلتين فقط حسب المثال السابق( في شاشة العمل الظاهرة كما يلي: -

 
 نحصل على المخرجات التالية:   Okبالضغط على  -  

 
حيث قيم القطر الأول للمصفوفة عبارة عن قيم تباين السلسلتين    Cov-Varتباين  -هي عبارة عن مصفوفة تغاير - 

GDP  وTM2     بينما باقي القيم تمثل قيم التغاير بين السلسلتينGDP  و TM2 :ومن النتائج السابقة نستنتج أن 

Cov(GDP, TM2) = 0.0857, Var(GDP) = 4.923, Var(TM2) = 0.0188 

 لحساب الارتباط بين سلسلتين أو أكثر نتبع الخطوات التالية:حساب الارتباط بين المتغيرات:  -2- 5

Quick /Group Statistics /Correlations 
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 سم السلسلتين في شاشة الظاهرة كما يلي: إبكتابة  -

 
 نحصل على النتائج التالية:   Okبالضغط على  -  

 
حيث قيم قطر الأول للمصفوفة عبارة عن )وهي مصفوفة متناظرة( هي عبارة عن مصفوفة معاملات الارتباط -   

قيم الارتباط بين كل سلسلة ونفسها لذلك قيم القطر تأخذ القيم الواحد الصحيح بينما باقي القيم تمثل قيم معامل 
 ومن النتائج السابقة نستنتج أن:  TM2و  GDPالارتباط بين السلسلتين   

ρ𝐺𝐷𝑃,𝑇𝑀2 = r𝐺𝐷𝑃,𝑇𝑀2  = 0.2812 
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 الانحدار الخطي البسيط -خامسا
 تمهيد: 

في    Eviewsباستخدام برنامج    الانحدار الخطي البسيطتقدير نموذج  من خلال هذا الفصل نتطرق فيه إلى كيفية  
جراء التقدير النقطي والتنبؤ النقطي في نموذج الانحدار الخطي البسيط باستخدام إالعنصر الأول منه ثم إلى كيفية  

 . الأخيروبعض الاختبرات الاحصائية المرتبطة بذلك في    Eviewsبرنامج  

 ولغرض ايجاد ذلك نتبع ما يلي:  GDPعلى   TM2نقوم بايجاد انحدار    01المثال  نطلاقا من المثال السابق  إ
 شكل الانتشار بين السلسلتين: -1

Quick→Graph→ ok  

 . المتغير المستقل أولا ثم المتغير التابع على  وفيه نحدد أسماء المتغيرات بالضغط   series listيظهر مبرع حوار  -
ما   كما    Regression Lineنختار    Fit linesفي    ثم  Scatter  نختار   Graph typeمن خلال مربع الحوار    - 

 يلي:

 
 نتحصل على الشكل التالي:  okبالضغط على  - 
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د من طبيعة العلاقة بين المتغيرين المدروسين هل هي علاقة خطية أم كأ من خلال شكل الانتشار أعلاه يمكن الت-

 لا. 
 : Eviewsباستخدام برنامج  الانحدار الخطي البسيط   تقدير النموذج-2

 :لغرض تقدير نموذج الانحدار الخطي البسيط نتبع الخطوات التالية
Quick→Estimate Equation→ ok  

 

 سم إسماء المتغيرات بحيث نكتب  أنقوم بكابتة    Equation Estimation  فيظهر مربع الحوار التالي ومن خلال  
 أو العكس.   C ثم الحد الثابت GDP سم المتغير المستقل إثم نكتب  TM2 وهنا في مثالنا نكتب  المتغير التابع أولا 

الصغرى    Estimation Settingsوفي   المربعات  طريقة  وهنا نحدد  التقدير  في  المستخدمة  الطريقة  -LSنحدد 

Least Squares  ومن خلال ،Sample  لة )العينة( المعتمدة في التقدير وهذا يفيدنا عندما نريد نحدد السلس
 : كما يلينتقاء جزء فقط من فترة الدراسة لكي نقوم بتقدير النموذج وفقها وليس على طور فترة الدراسة  إ

 
 : نتحصل على ما يلي  okبعد الضغط على  -
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  لنا ما يلي:ينعلاه التي توضح نتائج تقدير النموذج يتبأالنافذة الجديدة    من خلال  تحليل نتائج التقدير:-3
 : النموذج المقدرة حيث  معلمات قيم  التظهر لنا   Ceofficientمن خلال العمود  -
   0,0174قيمة معامل الميل هي:    -
 0,0803الحد الثابت هي:  معامل  قيمة   -
القيم الاخطاء المعيارية للمعلمات المقدرة، حيث قيمة الخطأ المعياري لمعامل   تظهر  Std-Errorمن خلال العمود    - 

 .0,0325قيمة الخطأ المعياري للحد الثابت هو:    و 0,0126الميل هو:  
تظهر القيم المحسوبة لاحصائئية ستيودنت للمعلمات المقدرة، حيث قيمة إحصائية   Statisticمن خلال العمود    -

 . 2,468وقيمة إحصائية ستدودنت للحد الثابت هي:   1,3748ستدودنت لمعامل الميل هي:  
المقدرة والتي يمكن من  المللمع   (t)حصائية ستدودنت لإالمقابلة  تظهر القيم الاحتمالية   Probمن خلال العمود   -

  0,01أو    0,05خلالها اتخاذ قرار معنوية أو عدم معنوية المعلمات المقدرة وذلك بعد مقارنتها مع مستوى المعنوية  

غير ننا نقول أن المعلمة المعنية  إ، حيث إذا كانت قيمة الاحتمال المقابل أكبر من مستوى المعنوية المحدد ف0,1أو  
من   قلأ  0,0218مقدر معلمة الحد الثابت معنوية لان الاحتمال المقابل يساوي  وفقا لنتائج أعلاه  معنوية مثلا  

 . 0,1830ي  او معنوي لان الاحتمال المقابل يسليس  في حين مقدر معامل الميل   0,10و  0,05مستويات المعنوية  
 يضا كل من: أكما يظهر من خلال نتائج تقدير النموذج  

النتائج من خلال  والتي تدلنا على القدرة التفسيرية للنموذج المقدر،    R-Squared  قيمة معامل التحديد •
Rأعلاه يتبين أن:   − Squared = مفسرة من   TM2من التغيرات في    %7,91أي أن    0.0791

 تعود لعوامل عشوائية غير ظاهرة في النموذج.  %92,09خلال النموذج المقدر وباقي النسبة والتي بـــ  
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المصحح   • التحديد  معامل  أن :  Adjustd R-Squaredقيمة  يتبين  أعلاه  النتائج  خلال  من 
Adjustd R − Squared = أي أن هناك نسبة منخفضة جدا من التغيير الكلي في الكتلة     0.0372
 النقدية مفسرة عن طريق النموذج المقدر. 

لاه يتضح أن أع من نتائج    : فيشر الخاص بالمعنوية الكلية للنموذجصائية  ح قيمة اختبار والاحتمال المقابل لا •
F − statistic = لها     1,89 المقابل  Prob(Fوالاحتمال  − statistic) = وهنا    0.1830

النموذج   المقابل لاحصائية  ليس  يتضح أن  من مختلف مستويات كبر  أ   فيشرمعنويا كليا لأن الاحتمال 
 .المعنوية

 تباع الخطوات التالية:يمكن كتابة النموذج أعلاه في شكله النهائي من خلال البرنامج بإ  هللاشارة فقط فإن •
 : نذهب إلى  لنموذج انافذة التقدير  من  -

View→Representations 

 

 
 يمكن نسخ نتائج النموذج المقدر كما يلي: كما  -

TM2 = 0.0174153826926*GDP + 0.0803137922299 

 
 : Eviewsباستخدام برنامج    التقدير النقطي في نموذج الانحدار الخطي البسيط-4
أولا   .وحدة نقدية  3,54في هذه السنة هي    GDPبافتراض أن قيمة    2024في سنة    TM2لغرض معرفة قيمة     

 التالي: نقوم بالتعديل  في منطقة الأوامر ثم   - للنموذج المقدر-علاه أنقوم بنسخ المعادلة 
Scalar TM22024 = 0.0174153826926*3.54 + 0.0803137922299 

 نتحصل على ما يلي:   okبعد الضغط على  -
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 . 0,1419وتساوي    2024في سنة   TM2تمثل قيمة    TM22024حيث  

 
 
 التقدير المجالي والتنبؤ المجالي:-5

إذ بالضغط عليها يظهر   nameبعد تقدير النموذج نقوم بتخزينه إذ من خلال نافذة الحوار للنموذج المقدر ومن  
 مربع الحوار التالي: 

 
 نتائج النموذج المقدر.   نيتم تخزي OKوبالضغط على    eq01و نترك الاسم  أنختار اسم معين للنموذج المقدر -
 نتبع الخطوات التالية:  workfileمن القوائم الاساسية للبرنامج ومن نافذة ملف العمل  بعد ذلك  -

Proc →Structure→ Resize Curent Page→ok  

من سنة   DGPساس أنه يتم التنبؤ بقيم  أعلى    2026نكتب    End date  يظهر مربع الحوار التالي وفي خانة -
2024-2026 : 
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وبتأكيد ذلك الخيار يظهر لدينا مربع الحوار التالي الذي يطلب منا تأكيد تغيير حجم العينة    okضغط على  بال-

 : كما يتبين أدناه   Yesمن خلال الضغط على  

 
 ولتكن مثلا كما يلي:   2026الى   2024من سنة   GDPلسلسلة  ا  قيم  ندخل بعد ذلك  -

2026 2025 2024 T 

5.62 4.45 3.54 GDP 

 كما يظهر أدناه: -
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  Forecastنختار  تقدير النموذج  في السابق ومن نافذة    ا تم حفظه التي  Eq01بعد ذلك نقوم بفتح المعادلة المقدرة  -

 وبالضغط عليها يظهر لنا مربع الحوار التالي: 
  fليه حرف إ مضافا  Forecast nameسم المتغير الجديد في خانة نجد أن البرنامج قام بكتابة إ -

 )كما يمكن تغيير إسم المتغير هنا(
 2SE∓فتراضي إيمكن في هذه الخطوة تحديد الخطأ المعياري للتقدير بحيث يعتمد على مجال   -

 
 نتحصل على ما يلي:   okبالضغط على   -
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القيم في نافذة ملف العمل وبعد فتحها نتحصل على    TM2f  المتنبؤ بها نجد أن البرنامج قد قام بانشاء السلسلة  -
 : 2026- 2024خلال فترة التنبؤ   دناهأكما يظهر  بها    تنبؤ  الم

 
 إيجاد المرونة:-6
 نذهب إلى:   Equationمن خلال نافذة تقدير  -

View →Coefficient Diagnostics→ Scaled Coefficients→ok  

 : Elasticity at Meansنتحصل على الجدول أدناه حيث تمثل المرونة بالقيمة المقابلة لكل متغير في عمود  -
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 . المرونة لغرض مقارنة قيمتها مع الواحد لمعرفة قوة المرونة ومع الصفر لمعرفة اتجاههاحساب  همية  أتكمن -
 : عالممجال الثقة للم -7
 نذهب إلى:   Equationمن خلال نافذة تقدير  -

View →Coefficient Diagnostics→ Confidence intervals→ok  

 يظهر لدينا مربع الحوار التالي:-

 
 ما يلي:  نتحصل على okثقة واحد وبالضغط على  مستوى  كما يمكننا اختيار -

 
 لنموذج المقدر: لسلسلة بواقي  -8
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 نذهب إلى:   Equationمن خلال نافذة تقدير  -
View→Actual-Fitted-Residaul → Actual-Fitted-Residaul Table → ok 

 يظهر لنا الجدول التالي: -

 
  Fittedوالعمود الثان يحتوى على القيم المقدرة للمتغير  Actualيحتوي على القيم الفعلية للمتغير   العمود الأول-

 Residaulتمثيل البيان للبواقي  لوالعمود الرابع يمدنا البرنامج با   Residaulوالعمود الثالث يحتوي على قيم البواقي  

Plot . 
  Fittedوعلى القيم المقدرة للمتغير    Actualالقيم الفعلية للمتغير  كما يمكن الحصول على التمثيل البيان لكل من  -

  Residaulوعلى قيم البواقي  

 بالذهاب إلى:   Equationمن خلال نافذة تقدير  
View→Actual-Fitted-Residaul → Actual-Fitted-Residaul Graph → ok 

 التالي:   شكل يظهر لنا ال-
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 اختبار فرضية طبيعية الأخطاء:-9
 ذلك تعطىمن فرضيات طريقة المربعات الصغرى أن تكون بواقي النموذج المقدر تتبع التوزيع الطبيعي، ولاختبار  -  

 على الشكل التالي: الاختبار  الفرضيات  
 : الاخطاء لا تتبع التوزيع الطبيعي 1Hالفرضية البديلة ل  ب مقا : الاخطاء تتبع التوزيع الطبيعي0Hالفرضية الصفرية 

 لاختبار هذه الفرضية نتبع الخطوات التالية:-
 :نتبع الخطوات التالية  Equationمن خلال نافذة تقدير  -

View→ Residual Diagnostics → Histogram-Normality Test→ ok 

والذي يتبين من خلاله المدرج التكراري للبواقي، وعلى يمين الشكل نجد بعض الإحصائيات    التالي  شكليظهر لنا ال-
وأدنى   Maximumوأعلى قيمة    Medianوالوسيط    Meanالخاصة بحد الخطأ العشوائي كالمتوسط الحسابي   

المعياري    Minimumقيمة   الالتواء    Std.Devوالانحراف  وفي Kurtusisوالتفرطح    Skewnessومقياس   ،
بحيث إذا كان الاحتمال المقابل ، Probوالاحتمال المقابل لهذا الاختبار   Jarque-Beraالاخير نجد قيمة اختبار  

 لهذا الاختبار أكبر من مستوى المعنوية نقبل الفرضية الصفرية التي تنص على أن الاخطاء تتبع التوزيع الطبيعي. 
 وفقا للنتائج أعلاه فإن: -   

𝑃𝑟𝑜𝑏𝐽𝐵 = 0.0651 > 0.05 
 أي أن البواقي تتبع التوزيع الطبيعي.
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 فرضية عدم عشوائية المتغير المستقل: -10

 وجد ارتباط بين المتغير المستقل للنموذج المقدر وحد الخطأ أي أن: عدم    والتي نعني بها 
Cov(Xt, Ut) = 0 

 المتغير التابع، واختبار ذلك نذهب إلى:   عنتغير المستقل وحد الخطأ المتهدف إلى عزل تأثير كل من  والتي  
المتغير المستقل  من خلال نافذة  - لمثالنا  و العمل نظلل كل من سلسلة  البواقي    TM2وفقا    Resid01وسلسلة 

 ذهب إلى: ن
Quick→ Group Statistics → Covariances→ ok 

 التالي:   شكلالعلى    نتحصل على مصفوفة التباين والتباين المشترك-

 
 نلاحظ أن: -

Cov(𝐺𝐷𝑃t, Ut) = 3.93 × 10
−17 = 0 

 الخطأ   د مستقل عن ح  GDPفالمتغير المستقل    منهو 
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 نموذج الانحدار الخطي المتعدد   -سادسا

 تمهيد: 
لاستكشاف العلاقة بين   (Multiple Linear Regression)يستخدم نموذج الانحدار الخطي المتعدد  

تابع   المستقلة    (Dependent Variable)متغير  المتغيرات  من  .  (Independent Variables)ومجموعة 
هذه  واتجاه  قوة  وتقدير  التابع،  المتغير  على  المستقلة  المتغيرات  هذه  تأثير  تحديد كيفية  إلى  النموذج  هذا  ويهدف 

وتطبيق بعض الاختبارات الاحصائية لاختبار مدى   هذا النموذجتقدير  ل  Eviewsبرنامج  ونستخدم هنا    التأثيرات.
   صلاحيته.

بالتطرق إلى الصيغة العامة لنموذج الانحدار الخطي العنصر نقوم في هذا : نموذج الانحدار الخطي المتعدد تقديم-1
المتعدد وفرضياته باعتباره من بين النماذج الخطية في المعلمات، إلا أنها قد تكون خطية أو غير خطية في المتغيرات 

 تعدد. وذلك بالتطرق إلى الصياغة الرياضية للنموذج الانحدار الخطي المتعدد، ثم فرضيات نموذج الانحدار الخطي الم
 الصياغة الرياضية للنموذج الانحدار الخطي المتعدد -1-1

𝑌𝑡 = 𝛽1𝑋1𝑡 + 𝛽2𝑋2𝑡 + 𝛽3𝑋3𝑡 +⋯+ 𝛽𝑘𝑋𝑘𝑡 + 𝑢𝑡 ∀𝑡 = 1,2,… , 𝑛 
𝑡 = 1: 𝑌1 = 𝛽0 + 𝛽1𝑋11 + 𝛽2𝑋12 +⋯…+ 𝛽𝑘𝑋1𝑘 + 𝑢1
𝑡 = 2: 𝑌2 = 𝛽0 + 𝛽1𝑋21 + 𝛽2𝑋22 +⋯ . .+𝛽𝑘𝑋2𝑘 + 𝑢2

……………………
𝑡 = 𝑛: 𝑌𝑛 = 𝛽0 + 𝛽1𝑋𝑛1 + 𝛽2𝑋𝑛2 +⋯ . . +𝛽𝑘𝑋𝑛𝑘 + 𝑢𝑛

 

 يمكن كتابة ذلك على الشكل المصفوفي التالي: 
Y𝑛.1 = X𝑛.(𝑘+1)β(𝑘+1).1 + U(𝑛.1) 

 حيث: 

𝑌 =

(

  
 

𝑦1
𝑦2
⋮
𝑦𝑡
⋮
𝑦𝑡)

  
 
; X =

(

 
 
 

1 𝑥11 𝑥21 … 𝑥𝑘1
1 𝑥12 𝑥22 … 𝑥𝑘2
⋮ ⋮ ⋮ …
1 𝑥1𝑡 𝑥2𝑙 … 𝑥𝑘𝑙
⋮ ⋮ ⋮ … ⋯
1 𝑥1𝑛 𝑥2𝑑 … 𝑥𝑘𝑛)

 
 
 
; 𝛽 =

(

 
 
 
 

β0
β1
β2
⋮
.
⋮
βk)

 
 
 
 

;𝑈 =

(

  
 

𝑢1
𝑢2
⋮
.
⋮
𝑢𝑛)

  
 

 

ة لمعامل الحد قابلوهي القيمة الم  "1"يحتوي على القيمة    Xنلاحظ أن العمود الأول في المصفوفة  -
   β0الثابت 

 عدد المتغيرات المفسرة(   kعمود ) k+1سطر و  nذات    Xوالمصفوفة  -
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 فرضيات نموذج الانحدار الخطي المتعدد -1-2
أين مجموع الأخطاء يكون يساوي الصفر معناه أن الأخطاء لا تبدي أي  الأمل الرياضي للأخطاء معدوم:-01

 أثر مجتمعة على المتغير التابع ونعبر عن ذلك بالعلاقة التالية: 
E(𝑢) = 0, (∑𝑢𝑡 = 0) 

 مهما تغير الزمن.   أي أن الأخطاء لها تباين ثابت   :homoscedasticityثبات تباين الأخطاء-02

E(𝑢𝑢′) =

(

  
 

𝐸(𝑢1
2) 𝐸(𝑢1𝑢2) 𝐸(𝑢1𝑢3) ⋯ 𝐸(𝑢1𝑢𝑛)

𝐸(𝑢2𝑢1) 𝐸(𝑢2
2) 𝐸(𝑢2𝑢3) ⋯ 𝐸(𝑢2𝑢𝑛)

𝐸(𝑢3𝑢1) 𝐸(𝑢3𝑢2) 𝐸(𝑢3
2) ⋯ 𝐸(𝑢3𝑢𝑛)

⋮ ⋮ ⋮ ⋮ ⋮
𝐸(𝑢𝑛𝑢1) 𝐸(𝑢𝑛𝑢2) 𝐸(𝑢𝑛𝑢3) ⋯ 𝐸(𝑢𝑛

2) )

  
 

 

E(uu′) =

(

 
 

σ2 0 0 ⋯ 0
0 σ2 0 0 0
0 0 σ2 ⋯ 0
⋮ ⋮ ⋮ ⋮
0 0 0 ⋯ σ2)

 
 
= σ2In ∀𝑡 

 وهي   أي أن قيم المتغيرات المستقلة يمكن مراقبتهاثابتة في المعاينة المتكررة وليست عشوائية:    𝑋المصفوفة  - 03
 غير مرتبطة بالأخطاء ونكتب: 

cov(𝑋, 𝑢) = 𝐸(𝑋′𝑢) = 0  ∀𝑡 
 تكون قابلة للقلب ويكون:  𝑋ن المصفوفة  أي أ :  𝐤أكبر من عدد المتغيرات 𝐧 حجم العينة -04

𝑅𝑎𝑛𝑔 (𝑋) = 𝑘 < 𝑛 
𝑢𝑡 ونكتب:الأخطاء تتوزع طبيعيا: - 05 ⤳ 𝑁(0, σ

2In) 

 عدم وجود إرتابط بين المتغيرات المستقلة. -06

 :خذ المثال التالي وذلك بأ   Eviewsير نموذج الانحدار الخطي المتعدد في برنامج  د تق توضيح ما سبق نقوم بلغرض       
بيانات متعلقة بالانتاج    :  04المثال   العمل    Yالذي يشمل  المال  أوعنصر ر   ( بالساعات)  Lوعنصر  في   Kس 

 .الغذائية  الصناعات   تنشط في مجال مؤسسات  10
 المؤسسة 

 المتغير 

1 2 3 4 5 6 7 8 9 10 

Y 200 220 250 280 300 320 360 390 420 440 

L 80 90 120 160 180 180 240 270 300 320 

K 20 40 50 100 120 140 180 180 250 270 

 
 إختبار العلاقة الخطية:  - 2
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نقوم برسم شكل  المدرجة في نموذج الانحدار لمفسرة الغرض إختبار العلاقة الخطية بين المتغير التابع وباقي المتغيرات 
 الانتشار كما يلي: 

 نذهب إلى: -
Quick→ Graph → ok 

يث نكتب أسماء المتغيرات المفسرة بح  L K Yسماء المتغيرات:  أع الحوار التالي نقوم بكتابه فيه  ربنتحصل على م-
 كما يظهر أدناه: أولا  

 
 fit linesمن قائمة   Regression Lineونختار  Graph Typeأسفل قائمة    Scatterثم نختار  -     
 كما يلي: Multiple seriesمن   Lower triangular matrixنختار  ثم 

 
 : تحصل على الشكل التالين  okبالضغط  -
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علاه يتضح أن معظم نقاط تقع على خط المستقيم المشار إليه في الشكل مما يدل أمن خلال شكل الانتشار  -  

وعنصر   Yويتضح كذلك أن هناك علاقة طردية بين الكمية الانتاج    Kو  Lوكل من    Yعلى وجود علاقة خطية بين  
 Kس المال  أ بالساعات وعنصر ر   Lالعمل  

 ختبار معنويتها:إو حساب معاملات الارتباط  -3
 ردنا حساب معاملات الارتباط بين المتغيرات نتبع الخطوات التالية: أذا  إ

 ليل )تحديد( المتغيرات في ملف العمل. ضنقوم بت-
 يمن للفأرة ونذهب إلى: نضغط على الزر الأ-

Y K L→ Open→ Open as group → ok 

 ثم نذهب إلى: -
View→ Covariance Analysis 

 يظهر مربع الحوار التالي: -
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  Probability [t]=0حتمال المقابل  إ، و T-statistic، والاختبار  Correlationمن النافذة أعلاه نحدد الخيار  -

 لمعاملات. 
 تحصل على مصفوفة معاملات الارتباط أدناه:ن  okبالضغط  -

 
 

 

 ختبار معنويتها: إو حساب معاملات الارتباط الجزئية  -4
نكتب    covariance analysisنافذة    من خلال لإيجاد معاملات الارتباط الجزئية نتبع الخطوات السابقة ولكن  

 . Partial analysisفي خانة    أسماء المتغيرات المراد تثبيتها
 كما يظهر أدناه:    Kنثبت المتغير     𝑟𝑌𝐿/𝐾فمثلا لحساب معامل الارتباط الجزئي-

 
 ما يلي: تحصل على  ن  okبعد الضغط  -
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 :  Eviews باستخدام برنامج   الانحدار الخطي المتعدد  تقدير النموذج-5

لتقدير نموذج الانحدار الخطي المتعدد نتبع نفس خطوات تقدير نموذج الانحدار الخطي البسيط من خلال كتابة     
 :منطقة الأوامرفي   مر التالي الأ

Ls Y L K C 

 تحصل على ما يلي: ن  ok  على  بعد الضغط -
 

 
 النموذج من خلال الخطوات التالية:    ملاحظة:  يمكن تقدير
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سماء المتغيرات )بحيث نكتب المتغير التابع أولا( ونختار طريقة التقدير كما يظهر أفي مربع الحوار الذي يظهر نكتب  -

 أدناه: 

 
 تحصل على نتائج تقدير النموذج السابقة.ن  okبالضغط على  -
 اختبار فرضية طبيعية الاخطاء:-6

بنفس الطريقة السابقة في حالة الانحدار الخطي البسيط نقوم باختبار فرضية طبيعية الاخطاء لهذا النموذج المتعدد      
 ونتحصل على نتائج اختبار كما تبدو أدناه: 
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ومنه    0,05أكبر من مستوى المعنوية    0,57تساوي    Jarque-Beraيتبين أن قيمة الاحتمال المقابل لاختبار  -
 نقبل الفرضية الصفرية التي تنص على أن الاخطاء تتبع التوزيع الطبيعي. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  ته معالجو   عنه  ختبارات الكشف إالارتباط الذاتي للأخطاء:  -سابعا
 : تمهيد

في مجال التحليل الإحصائي، وخاصة عند التعامل مع نماذج الانحدار، يعتبر افتراض عدم وجود ارتباط ذاتي بين   
الأخطاء من الافتراضات الأساسية التي يجب تحققها لصحة النتائج. ولكن في الواقع، قد يحدث في كثير من الأحيان 

يهدف . لذا  "مشكلة الارتباط الذاتي"   ـــهور ما يعرف بأن تكون الأخطاء مرتبطة ببعضها البعض، مما يؤدي إلى ظ
هذا الفصل إلى تزويد القارئ بفهم شامل لمشكلة الارتباط الذاتي، وكيفية الكشف عنها ومعالجتها باستخدام برنامج 

Eviews  .  من خلال العناصر التالية:  يتناول الفصل الجوانب النظرية والتطبيقية لهذه المشكلةوعليه 

 . تعريفه وأسبابه في العنصر الأول   الارتباط الذاتي للأخطاء ▪
 .  بين الأخطاء في العنصر الثانختبارات الكشف على الارتباط الذاتي إ ▪
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 .بين الأخطاء في العنصر الثالث  معالجة مشكلة الارتباط الذاتي  ▪
 تعريفه وأسبابه:   الارتباط الذاتي للأخطاء-1

نتيجة   هو ظاهرة إحصائية تحدث في نماذج الانحدار (Autocorrelation) بين الأخطاء  ذاتيالارتباط ال
بمعنى آخر، الأخطاء لا تظهر بشكل عشوائي تماما، بل هناك نمط النموذج المقدر،  وجود علاقة خطية بين أخطاء

ينحرف عن  الارتباط  هذا  المختلفة.  الملاحظات  أو عبر  الزمن  مر  البعض على  ببعضها  ارتباطها  معين في كيفية 
 .الافتراض الأساسي في العديد من النماذج الإحصائية، وهو أن الأخطاء مستقلة وموزعة بشكل طبيعي

 :الذاتي للأخطاءالأسباب الرئيسية للارتباط  - 1- 1
o عندما يتم حذف متغيرات تفسيرية مهمة من النموذج، فإن  لأنه  ج دم تضمين متغيرات مهمة في النموذ ع

  ا.تأثير هذه المتغيرات "ينتقل" إلى الأخطاء، مما يؤدي إلى وجود علاقة بينه
o إذا كانت العلاقة بين المتغيرات ليست خطية تماما، ولكن تم افتراض علاقة  ،  خطأ في تحديد شكل العلاقة

 . خطية في النموذج، فإن الأخطاء ستحتوي على جزء من هذه الانحرافات غير الخطية، مما يؤدي إلى ارتباطها
o المتطرفة  النقاط :وجود نقاط متطرفة (Outliers)  يمكن أن تؤثر بشكل كبير على تقديرات المعاملات في

  .النموذج، مما يؤدي إلى زيادة الارتباط بين الأخطاء 
o   نتهاكات لشروط الانحدار الخطي، مثل عدم التجانسإ  وجود إن  :  ستيفاء شروط الانحدار الخطيإعدم 

(Heteroscedasticity)   أو عدم الطبيعية (Non-normality)   رتباط إ الأخطاء، يمكن أن يؤدي إلى
 .امبينه

o في البيانات السلاسل الزمنية، تكون القيم مرتبطة ببعضها البعض عبر الزمن. ت:  طبيعة المتسلسلة للبيانا
على سبيل المثال، سعر سهم اليوم قد يكون مرتبطا بسعره في الأمس. هذه الطبيعة المتسلسلة يمكن أن 

  .تؤدي إلى ارتباط الأخطاء أيضا
 :النتائج والآثار- 2- 1

o يؤدي الارتباط إلى زيادة تباين تقديرات المعاملات، مما يجعلها أقل دقة: قديرات معاملات غير فعالةت . 
o اختبارات  :  اختبارات فرضيات غير صحيحة(t) و(F)    المستخدمة لتقييم أهمية المعاملات تصبح غير

 . صحيحة، مما يؤدي إلى استنتاجات خاطئة حول العلاقة بين المتغيرات
o  يؤدي الارتباط إلى زيادة عدم يقين التنبؤات، مما يجعلها أقل دقة:  تنبؤات غير دقيقة . 
o مما يؤثر على بناء فترات الثقةتقديرات الخطأ المعياري تكون متحيزة ومضللة ،. 
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o  معامل التحديد (R²) صطناعيإون مضخما بشكل يك. 
 
 : بين الأخطاءاختبارات الكشف على الارتباط الذاتي  -2

مرتبطة ولعل من أسباب ظهور هذه غير  إن استقلال حدود الخطأ عن بعضها البعض يعني أن تكون حدود الخطأ  
خطأ في توصيف هناك  هو غياب متغير تفسيري مهم في نموذج الانحدار أو كما تم الاشارة إليه في السابق المشكلة  

منتظم في قياس بعض متغيرات النموذج ...الخ، وينتج عن وجود   أعدم دقة البيانات كوجود خطالانحدار أو  نموذج
مشكل الارتباط الذاتي للأخطاء بأن تكون معلمات النموذج المقدرة غير متحيزة لكن قيمتها العددية تكون غير 

أي أنها لا تحقق أقل تباين مما يجعل مجالات الثقة للمعالم طويلة وكذلك   ، دقيقة، كما أنها لا تتمتع بخاصية الكفاءة
 ختبار الفرضيات حول المعالم المقدرة. إخطاء المعيارية للمقدرات متحيزة مما يمدنا بنتائج زائفة بخصوص الأ تكون  

 هناك عدة اختبارات لاختبار فرضية الاستقلال بين حدود الاخطاء نوجزها في: 
دى ح لاخطاء من خلال التمثيل البيان للبواقي بإبين ايمكن الكشف عن الارتباط الذاتي    الطريقة البيانية: - 1- 2

 الطرق التالية:
كدالة في الزمن وإذا تبين في الرسم وجود نمط معين كما المقدرة  رسم حدود الأخطاء اولى:  الطريقة الأ- 1- 1- 2

 . الأخطاءرتباط ذاتي بين  إيعني وجود    لك يظهر أدناه في الاشكال البيانية فذ 
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فإن ذلك يدل على وجود استقلال بين حدود معين في الشكل البيان  ذا تبين عدم وجود نمط  إفي الحالة العكسية  -
 كما يظهره الشكل أدناه:   )عدم وجود ارتباط ذاتي(  الخطأ

 
 باتباع الخطوات التالية:  Eviewsة برنامج  سطجراء ذلك بواإيتم  -
 من نافذة تقدير النموذج نذهب إلى: -

View→ Actual, Fitted, Residuals→ Standardized Residual Graph 

 
فإذا    (t-1)على البراقي في اللحظة    (t)المنحنى الذي يمثل انحدار البواقي في اللحظة  رسم    الطريقة الثانية:- 2- 1- 2

رتباط ذاتي بين حدود الخطأ إو سالب( فإن ذلك يدل على وجود  أموجب  تجاه التغيير نفسه  إتبين وجود نمط معين ) 
 كما يلي: 
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 نقوم بتنفيذ ذلك في برنامج كما يلي: -
 من نافذة ملف العمل نذهب إلى: -

Quick→ Graph 

 :فيه  نقوم بكتابة   الذي يظهرمربع الحوار  من خلال  -
resid resid(-1) 

 
 بع الحوار أدناه: ر نتحصل على م okبالضغط على  -

 
 نتحصل على الشكل أدناه:  okبالضغط على  و   Scatterنختار  Specificمن خلال  -
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 ملاحظة: 

  nameسم الشكل في خانة  إثم ندخل    Freezeلتخزين الشكل أعلاه في ملف العمل نقوم بالضغط على      

 نجد أن البرنامج قام بتخزين الشكل في ملف العمل وفقا للاسم المعطي له.  okوبالضغط على  
الرسم البيان   Correlogramدالة  تمثل    :Correlogramدالة   باستخدام  اتيكشف عن الارتباط الذال- 2- 2

حيث يتم حساب معاملات العينة   (Lags)ختلف الفجوات الزمنية لم لدالة معاملات الارتباط الذاتي بين البواقي  
 كما يلي:  𝜌𝑠للارتباط الذاتي للبواقي 

𝜌̂𝑠 =
∑ 𝜌𝑡𝜌𝑡−𝑠
𝑛
𝑡=𝑠+1

∑ 𝜌𝑡
2𝑛

𝑡=1

, 𝑠 = 1,… ,𝑚 

يقترح أن لا تزيد قيم عن و  𝑚الى   1: تمثل الفجوة الزمنية التي تأخذ القيم من  𝑡  ،𝑠حيث: تمثل البواقي عند الفترة  
𝑚ربع المشاهدات أي  ≤
𝑛

4
 

تتناقص ببطئ وتقترب من الصفر بزيادة   Correlogramإذا تبين أن قيم معاملات الارتباط الذاتي في شكل  -
 . ارتباط ذاتي من الدرجة الأولىطول الفجوة الزمنية فإن ذلك يدلنا على وجود  

 الارتباط الذاتي بين الاخطاء:عن  كشف ل الاختبارات الاحصائية ل- 3- 2
بعد تقدير نموذج الانحدار في نتائج التقدير تظهر قيمة   :Durbin-Watsonختبار داربين واتسون  إ- 1- 3- 2
 والتي منها:   يفترض بعض الشروط، ولتطبيق هذا الاختبار  DWحصائية  إ

 . وجود الثابت في معادلة الانحدار-
𝑈𝑡يسمح بالكشف عن الارتباط من الدرجة الاولى فقط أي لما يكون:   DWختبار  إ- = 𝜌𝑈𝑡−1 + 𝑣𝑡 
 (𝑌𝑡−1)إبطاء المتغير التابع متغيرات متباطئة كمتغيرات مفسرة كعدم توفر في معادلة الانحدار  -
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𝑛كون تحجم العينة يجب أن  - ≥  .مع عدم وجود مشاهدات مفقودة )للمتغير التابع والمستقل(  مفردة  15
 الاخطاء يجب أن تتبع التوزيع الطبيعي. -

 في:   لاكتشاف الارتباط الذاتي بين الاخطاء DWالقصور في استخدام اختبار  تتمثل بعض  
 . لة وجود متغيرات متباطئة زمنيا في النموذجاختبار غير مناسب في ح إ-
لا يمدنا بنتائج واضحة بخصوص الارتباط الذاتي كما أنه يصلح للكشف عن   DWختبار  ا  في بعض المجالات منه -

 وجود الارتباط الذاتي من الدرجة الاولى فقط. 
 شكال الارتباط غير خطية. ألا يصلح إذا كانت  -
 كما يلي:   DWختبار  احصائية  إتعطى -

𝑑𝐷𝑊 =
∑ (𝑒𝑡 − 𝑒𝑡−1)

2𝑇
𝑡=2

∑ 𝑒𝑡
2𝑇

𝑡=1

 

𝑑هي تقريبا:  𝜌و  dالعلاقة بين  - = 2(1 − 𝜌̂) 

 تعطى فرضيات الاختبار كما يلي:-

{
𝐻0: 𝜌 = 0
𝐻1: 𝜌 ≠ 0

 

 دل ت  والفرضية البديلة،  عدم وجود ارتباط ذاتي من الدرجة الاولى بين حدود الاخطاءتدل    فرضية العدمحيث  
  .وجود ارتباط ذاتي من الدرجة الاولىعدم  على  

 مختلف قرارات وجود )عدم وجود( ارتباط ذاتي بين حدود الاخطاء: والمخطط التالي يبين 

 
 حيث: 

 -𝐷𝑊 → 𝜌أي أن:  : دل على وجود ارتباط ذاتي موجب0 → +1 . 

-𝐷𝑊 → 𝜌: دل على عدم وجود ارتباط ذاتي أي أن: 2 → 0 . 

-𝐷𝑊 → 𝜌: دل على وجود ارتباط ذاتي سالب أي أن: 4 →  ـ1−

,𝑑1]إذا كانت قيمة اختبار تنتمي إلى المجال       𝑑2]    4]أو المجال − 𝑑2, 4 − 𝑑1]  فإن اختبارDW   لا يمدنا
 . بأي قرار )وقوع قيمة احصائية الاختبار في منطقة الشك(
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 .حسب حجم العينة DW  الخاصة  ول اد الجتستخرج من   𝑑2و  𝑑1القيم :  ملاحظة
 : كما يلي  ينالتاليبعرض باقي الاختبارات الاحصائية مع التطبيق على المثالين  وفيما يلي نقوم  

التالية    :05ثال  الم البطالة  بينالتي تو لتكن لدينا المعطيات  العلاقة بين معدلات   CH   النمو الاقتصادي ومعدل 
GDP    كما يلي:  2023- 2011لاقتصاد ما خلال الفترة 

T 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 

CH 25 24.2 22 20 19 17 15 14 12.3 10 12.3 15.2 12.7 

GDP 1.2 0.9 1.7 2.1 2.5 3.1 4.1 4 4.7 5 5.1 3.5 4.1 

اختبر وجود الارتباط الذاتي بين الاخطاء في النموذج انحدار معدل البطالة على النمو   DWباستخدام اختبار      
 الاقتصادي؟

 الحل:
 تقدير نموذج الانحدار: -1
 

 
𝐷𝑊 واتسون-من نتائج التقدير أعلاه نجد أن قيمة اختبار داربين-2 = 2.306 
 أين تقع هذه القيمة بالنسبة للمخطط السابقلمعرفة وجود )غياب( الارتباط الذاتي بين الاخطاء نلاحظ  وعليه      

وقيمة   𝑑1 وعليه يجب تحديد قيمة  ءيبين مختلف قرارات وجود )عدم وجود( ارتباط ذاتي بين حدود الاخطا  الذي
𝑑2  واتسون وذلك وفقا لحجم العينة  -من الجداول الخاص باختبار داربينn   وعدد المتغيرات المستقلة المدرجة في

 )عدد المعالم باستثناء الحد الثابت(كما يظهر أدناه:   kنموذج الانحدار  
𝑛 وفقا لمثالنا لدينا حجم العينة   = 𝑘وعدد المتغيرات المستقلة 13 = 1 
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 : نجد أن أدناه ل داربين واتسون دو الجمن خلال  

 
𝑑1 قيمة- = 𝑑2وقيمة   1.01 = 4وقيمة   1.34 − 𝑑2 = 4 − 1.34 = 2.66 

 ومنه نجد أن: 
𝐷𝑊 = 2.306 ∈ [2, 2.68] 

𝐷𝑊: منطقةتنتمي لل  واتسون -اختبار داربين  قيمةأي أن   ∈ [2, 4 − 𝑑2] 

العدم  أي   فرضية  تدل على    نقبل  الدرجة الاولى بين حدود الخطأالتي  ارتباط ذاتي من  نرفض و  عدم وجود 
 بوجود استقلال بين حدود الخطأ.  OLSوبالتالي تحقق فرضية طريقة  بديلة  فرضية الال

 لتكن لدينا المعطيات التالية:   :06المثال  
 T 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 

Y 87.4 97.6 96.7 98.2 99.8 100.5 103.2 107.8 96.6 88.9 

X1 98.6 101.2 102.4 100.9 102.3 101.5 101.6 101.6 99.8 100.3 

X2 99.1 99.1 98.9 110.8 108.2 105.6 109.8 108.7 100.6 81 

X3 108.5 110.1 110.4 104.3 107.2 105.8 107.8 103.4 102.7 104.1 

 T 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 

Y 75.1 76.9 84.6 90.6 103.1 105.1 96.4 104.4 110.7 127.1 

X1 97.6 97.2 97.3 96 99.2 100.3 100.3 104.1 105.3 107.6 

X2 68.6 70.9 81.4 102.3 105 110.5 92.5 89.3 93 106.6 

X3 99.2 99.7 102 94.3 97.7 101.1 102.3 104.4 108.5 111.3 

  المطلوب:
باستخدام الشكل البيان   على باقي المتغيرات المفسرة ثم  Yقدر نموذج الانحدار الذي يمثل انحدار المتغير التابع     

 وجود ارتباط ذاتي بين الاخطاء في النموذج المقدر؟ تأكد من    DWباستخدام اختبار  و   للبواقي
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 الحل:  
 : تقدير نموذج الانحدار-1

 
 
 للمثال الثاني باستخدام الاختبارات السابقة:  اختبار وجود ارتباط ذاتي بين الاخطاء-2  
 باستخدام الشكل البياني للبواقي: -2-1  

 من نافذة تقدير النموذج نذهب إلى: -
View→ Actual, Fitted, Residuals→Residual Graph 

 
بين ذاتي  ارتباط  إمكانية وجود  من خلال الشكل أعلاه يتبين أن قيم البواقي تأخذ قيما دورية مما يعني أن هناك  -

 . حدود الخطأ
 :واتسون-اختبار وجود ارتباط ذاتي بين الاخطاء باستخدام اختبار داربين - 2- 2
 واتسون تساوي: -من نتائج التقدير أعلاه نجد أن قيمة اختبار داربين -

𝐷𝑊 = 1.0537 
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𝑛 وفقا لمثالنا لدينا حجم العينة   = 20 
𝑘وعدد المتغيرات المستقلة  = 3 

𝑑1 قيمة  نجد أن  05واتسون المبين في الملحق رقم  -داربين  لجدولوفقا   = 𝑑2وقيمة   1.00 = 1.86 
 ومنه: 

𝐷𝑊 = 1.0537 ∈ [1.00, 1.68] 
واتسون لا يمدنا -اختبار داربينفيمكن القول هنا أن  )منطقة اللاحسم(  لمنطقة الشكتنتمي   DWقيمة  أي أن   

وسنتوجه بالاعتماد   قبول )رفض( فرضية العدم  أو بخصوص   بأي قرار بخصوص وجود الارتباط الذاتي بين الاخطاء 
وفيما يلي نقوم بعرض المزيد  .لغرض الكشف عن الارتباط الذاتي بين حدود الخطا العشوائي ات اخرى على اختبار 

 . من الاختبرات الاحصائية بالاضافة للاختبارات السابقة
 
 
 
،  LM-test  مضاعف لاغرونج  يعرف كذلك باختبار   :Breush-Godfreyاختبار بروش كودفري  - 2- 3- 2

 )غياب(   توفرظل  يسمح هذا الاختبار باختبار الارتباط الذاتي بين الاخطاء عند مختلف درجات الارتباط، وفي  
من الدرجة   من خلال البحث عن العلاقة بين حدود الخطأ   ، ويتم ذلك متغيرات مبطئة في النموذج كمتغيرات مفسرة

P  :على النحو التالي 
𝑈𝑡 = 𝜌1𝑈𝑡−1 + 𝜌2𝑈𝑡−2 + 𝜌3𝑈𝑡−3 +⋯+ 𝜌𝑝𝑈𝑡−𝑝 + 𝑣𝑡 

 تعطى فرضيات الاختبار على النحو التالي: -

{
𝐻0: 𝜌1 = 𝜌2 = ⋯ = 𝜌𝑃 = 0
𝐻1: 𝜌𝑖 ≠ 0                       

 

 : حيث
 . طأرتباط ذاتي بين حدود الخإتدل على عدم وجود   : فرضية العدم-  
 .بين حدود الخطأ  رتباط ذاتيإتدل على وجود    : الفرضية البديلة-
 كما يلي:  Eviewsبرنامج  في  يتم تنفيذ هذا الاختبار    

 بالذهاب إلى:   Equationمن خلال نافذة تقدير  -
View→ Residaul Diagnostics → Serial Correlation LM Test→ ok 
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 Lagsفي      درجة الابطاء الزمني للاخطاء  بكتابةنقوم  Lag Specification من خلال مربع الحوار الذي يظهر  -

to include    التالي: مربع الحوار  في يظهر لنا كما 

 
 تحصل على نتائج الاختبار التالية: ن  okبعد الضغط  -

 
 

 :معالجة مشكل الارتباط الذاتي بين الاخطاء-3
 : نذكر منها ما يلي  إجراءات التقدير في حالة وجود مشكل الارتباط الذاتي بين الأخطاءهناك العديد من  

 طريقة أخذ الفرق الأول للمتغيرات المدرجة في النموذج. -
 Generalized Least Squares (GLS)طريقة المربعات الصغرى المعممة  -
 : طريقة الفرق الأول- 1- 3
 ح للمتغير التابع وللمتغيرات التفسيرية من خلال طر   ساب التغيير الحاصلوفقا لهذه الطريقة يتم تقدير النموذج بح  

 قيم المتغير للفترة السابقة من قيم المتغير للفترة الحالية ويعطى النموذج على الشكل التالي: 
 النموذج المقدر في المرحلة الاولى:-

𝑌𝑡 = 𝛽0 + 𝛽1𝑋1𝑡 + 𝛽2𝑋2𝑡 + 𝛽3𝑋3𝑡 + 𝑢𝑡 

 النموذج المقدر بعد أخذ الفرق الاول: -
∆𝑌𝑡 = 𝛽0 + 𝛽1∆𝑋1𝑡 + 𝛽2∆𝑋2𝑡 + 𝛽3∆𝑋3𝑡 + 𝑢𝑡 

 حيث: 
∆𝑋𝑗𝑡 = 𝑋𝑗𝑡 − 𝑋𝑗𝑡−1 
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 نكتب التعليمة التالية:  طريقة الفرق الأولوباستخدام  علاه من خلال البرنامج  أ الخاص بالمثال الثان  لتقدير النموذج  
LS D(Y) D(X1) D(X2) D(X3) C 

نتحصل على النموذج التالي:     

 
 التأكد من خلو النموذج من مشكل الارتباط الذاتي بين البواقي: -
 واتسون تساوي: -من نتائج التقدير أعلاه نجد أن قيمة اختبار داربين   

𝐷𝑊 = 2.39 
𝑛 وفقا لمثالنا لدينا حجم العينة - = 𝑘وعدد المتغيرات المستقلة )بعد أخذ الفرق الأول(  19 = 3 
𝑑1 قيمةنجد أن   05واتسون المبين في الملحق رقم  -داربين  وفقا لجدول- = 𝑑2وقيمة   0.97 = وقيمة   1.68

4 − 𝑑1 = 4 − 0.97 = 3.03 
4 − 𝑑2 = 4 − 1.68 = 2.32 

 ومنه نجد أن: 
𝐷𝑊 = 2.397 ∈ [2.32, 3.03] 

𝐷𝑊تنتمي للمنطقة:   واتسون -اختبار داربين  أي أن قيمة ∈ [4 − 𝑑2, 4 − 𝑑1]   اختبار و وهي منطقة الشك
DW ك نتجه إلى الاعتماد على اختبار أخر. للذ  لا يمدنا بأي قرار 

 
   :Breush-Godfrey  بروش كودفري اختبار  -
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 كما تم الاشارة اليه في السابق كما يلي: Eviewsل برنامج  إذ يتم تنفيذ هذا الاختبار من خلا

 بالذهاب إلى:   Equationمن خلال نافذة تقدير  -
View→ Residaul Diagnostics → Serial Correlation LM Test→ ok 

 Lagsنقوم بكتابة درجة الابطاء الزمني للاخطاء  في  Lag Specification من خلال مربع الحوار الذي يظهر  -

to include    التالي:   شكلالفي  يظهر لنا كما 

 
 تحصل على نتائج الاختبار التالية: ن  okبعد الضغط  

 
𝑃𝑟𝑜𝑏(𝐹ختبار فيشر   الاحتمال المقابل لاخلال قيمة  ومن       − 𝑠𝑡𝑎𝑡𝑖𝑠𝑡𝑖𝑐) = أكبر من مستوى   0,39

 . فرضية العدم بعدم وجود ارتباط ذاتي بين الاخطاء من الدرجة الثانيةوبالتالي نقبل  0,05المعنوية  
قيمة         أن  المقابل  كما  𝐿𝑀لاختبار  الاحتمال  = 𝑛𝑅2 = 𝑂𝑏𝑠 ∗ 𝑅 − 𝑠𝑞𝑢𝑎𝑟𝑒𝑑   يساوي و  الذي 

𝑃𝑟𝑜𝑏(𝑐ℎ𝑖 − 𝑠𝑞𝑢𝑎𝑟𝑒) = وبالتالي نبقل فرضية العدم بعدم وجود  0,05أكبر من مستوى المعنوية    0,27
 (.2  تساوي   خيرأتالارتباط ذاتي بين الاخطاء من الدرجة الثانية )لانه تم ادخال درجة  

 
تسمح هذه الطريقة   :Least Squares (GLS) Generalizedطريقة المربعات الصغرى المعممة  - 2- 3

 بالتخلص من مشكلة الارتباط الذاتي بين الأخطاء إذ نقوم بتقدير النموذج التالي: 
𝑌𝑡
∗ = 𝛽0

∗ + 𝛽1𝑋1𝑡
∗ + 𝛽2𝑋2𝑡

∗ +⋯+ 𝛽𝑝𝑋𝑝𝑇
∗ + 𝑣𝑡 

 كما يمكن كتابة ذلك على الشكل التالي: 
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𝑌𝑡 − 𝜌̂𝑌𝑡−1 = 𝛽0(1 − 𝜌̂) + 𝛽1(𝑋1𝑡 − 𝜌̂𝑋1𝑡−1) + 𝛽2(𝑋2𝑡 − 𝜌̂𝑋2𝑡−1) + ⋯

+ 𝛽𝑝(𝑋𝑝𝑡 − 𝜌̂𝑋𝑝𝑡−1) + (𝑢𝑡 − 𝜌̂𝑢𝑡−1) 

 ابة الاوامر التالية: تووفقا لذلك فإنه يمكن تطبيق ذلك في البرنامج من خلال انشاء متغيرات جديدة بك
genr 𝐷𝑌 = 𝑌 − ρ̂ ∗ Y(−1) 

genr DX1 = X1 − ρ̂ ∗ X1(−1) 

genr DX2 = X2 − ρ̂ ∗ X2(−1) 

genr DX3 = X3 − ρ̂ ∗ X3(−1) 

 التالية:نقوم بحسابها باحدى الطرق    (𝜌تقدير قيمة معامل الارتباط الذاتي )وقيمة معامل الارتباط  
: ففي حالة وجود ارتباط ذاتي من الدرجة الاولى نقدر قيمة معامل الارتباط الذاتي لبسيطةالطريقة الاولى: طريقة ا

 كما يلي: 
𝜌̂ = 1 − 𝐷𝑊 2⁄  

𝐷𝑊فمن خلال النموذج المقدر نحد أن قيمة  = 1.053 
 ومنه نجد أن: 

𝜌̂ = 1 − 𝐷𝑊 2⁄ =
2 − 1.053

2
= 0.4735 

𝜌̂ = 0.4735 
ρ̂نعوض قيمة معامل الارتباط الذاتي   بعد ذلك  =  في المتغيرات المحولة كما يلي:   0.4735

genr 𝐷𝑌 = 𝑌 − 0.4735 ∗ Y(−1) 

genr DX1 = X1 − 0.4735 ∗ X1(−1) 

genr DX2 = X2 − 0.4735 ∗ X2(−1) 

genr DX3 = X3 − 0.4735 ∗ X3(−1) 

 ونقوم بتقدير النموذج باستخدام المتغيرات المحولة كما يظهر أدناه:

 
 كما نقوم بتحويل قيمة الحد الثابت والتي تصبح تساوي: 
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𝛽̂0 = 𝛽̂0
∗ (1 − 𝜌̂)⁄ = −133.30 (1 − 0.4735)⁄ = −253,18 

 
 : وفقا لهذه الطريقة فإننا نقوم بتقدير النموذج التالي:: طريقة انحدار البواقيثانيةالطريقة ال-

𝜀𝑡 = 𝜌𝜀𝑡−1 + 𝑣𝑡 
𝜀𝑡 = 𝜌̂𝜀𝑡−1 

ويتم ذلك في أي نقوم باجراء تقدير لانحدار البواقي من الدرجة الاولى وبعده نستخرج قيمة معلمة معامل الارتباط 
 برنامج كما يلي: 

وفقا اسم لبواقي  جديدة لنقوم بانشاء سلسلة    Residبعد تقدير نموذج الانحدار والحصول على سلسلة البواقي  -
 وبعدها نكتب الامر التالي:   Residنقوم بنسخ قيمها من سلسلة  و   RSمغاير وليكن  

LS RS RS(-1)  

 نتحصل على ما يلي:   okبالضغط على  

 
 

 

𝜌̂ومنه نجد أن قيمة معامل الارتباط الذاتي  =  %10عند مستوى معنوية    كما أنه معنوي احصائيا  0.4623

 

 :Nagar-Theil  إحصائية  باستخدام  𝜌̂الطريقة الثالثة: تقدير -
 لدينا: 

𝜌̂ =
𝑛2(1 − 0,5𝐷𝑊) + (𝑘 + 1)2

𝑛2 − (𝑘 + 1)2
=
192(1 − 0,5𝐷𝑊) + (3 + 1)2

𝑛2 − (3 + 1)2
 

 أعلاه لدينا: 2من نتائج تقدير النموذج للمثال رقم  -
𝑘 = 3, DW = 1,053 
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𝜌̂ =
202(1 − 0,5 × 1,053) + (3 + 1)2

202 − (3 + 1)2
= 0,5348 

 بعد ذلك نقوم بالتعويض في قيم المتغيرات المحولة كما يظهر أدناه: -
  genr 𝐷𝑌 = 𝑌 − 0.5348 ∗ Y(−1) 

genr  DX1 = X1 − 0.5348 ∗ X1(−1) 

genr DX2 = X2 − 0.5348 ∗ X2(−1) 

genr DX3 = X3 − 0.5348 ∗ X3(−1) 

 : أعلاه ونتحصل على النموذج التاليأخيرا نقدر النموذج باستخدام المتغيرات المحولة -

 
 

تعتبر هذه الطريقة احدى طرق تقدير قيمة معامل الارتباط   :Orcutt-Cochrane: طريقة  رابعةالطريقة ال-
النموذج يعان من مشكل الذاتي   النموذج )ففي حالة  الذاتي الى  يتم اضافة رتبة الارتباط  الطريقة فإنه  وفقا لهذه 

وبعدها نقوم باختيار   MA  ثم باستخدام نموذج المتوسط المتحرك  ( AR(1)الارتباط الذاتي من الرتبة الاولى يتم اضافة  
وللاشارة يجب    Log Likelihoodويعظم قيمة    ssrو   Schwarzو  Akaike  النموذج ذي الاقل قيمة لمعيار 

 ويتم ذلك كما يلي:معنوية   MA(1)أو    AR(1)أن يكون النموذج معنويا وأن تكون معلمة  
 .كما يلي  نقوم بتقدير النموذج الاول:-1

Ls Y C X1 X2 X3 AR(1) 

 بالتطبيق في البرنامج يظهر كما يلي:
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 نختار:  Optionثم من خلال  -
-CLS     منMetod 
-Eviews legacy   من Optimization method 

 
 نتحصل على ما يلي:   okبالضغط على  
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 .ونجد أن النموذج المتحصل عليه يحتوى على معامل الارتباط الذاتي معنويا والحد الثابت في طبيعته الاصلية  
 . كما يلي :  ثانينقوم بتقدير النموذج ال-2

Ls Y C X1 X2 X3 MA(1) 

 علاه نتحصل على ما يلي: أبالتطبيق في البرنامج وبنفس الخطوات تقدير النموذج الاول 

 
 بعد ذلك نقوم بمقارنة بين النموذجين المقدرين كما يلي:-

 النموذج الثاني  النموذج الاول  المعيار 
Akaike 5.01 5.13 

Schwarz 5.15 5.38 

SSR 98.62 121.0098 

Log Likelihood -42.6 -46.38 

 أكبرو   SSRو  Schwarzو  Akaike  لمعياروعليه يظهر من الجدول أن النموذج الاول هو الذي يحقق أقل قيمة    
معنوية وعليه فإن القيمة المقدرة لمعلمة الارتباط الذتي   AR(1)كما أن قيمة معلمة    Log Likelihood  لـــ  قيمة

𝜌̂تقدر بـــ  = 0.811. 
قيمة معامل الارتباط الذاتي المحسوبة وفقا للطريقة   باستخدام وفي مواصلة تطبيق طريقة المربعات الصغرى المعممة  

نشاء متغيرات جديدة نقوم بكتابة الاوامر التالية وذلك لانا قمنا بحساب ولا  لانحدار البواقي  )الطريقة البسيطة(  الاولى
ρ̂قيمة معامل الارتباط الذاتي  = 0.4738: 

genr 𝐷𝑌 = 𝑌 − 0.4738 ∗ Y(−1) 

genr DX1 = X1 − 0.4738 ∗ X1(−1) 

genr DX2 = X2 − 0.4738 ∗ X2(−1) 
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genr DX3 = X3 − 0.4738 ∗ X3(−1) 

 وبعدها نقوم بتقدير النموذج باستخدام المتغيرات المحولة كما يظهر أدناه: 

 
النموذج الأصلي فالذي يطرأ عليه تغيير هو قيمة الحد الثابت والتي في  ويتم تفسير المعالم المقدرة كما هو  

 تصبح تساوي: 
𝛽̂0 = 𝛽̂0

∗ (1 − 𝜌̂)⁄ = −133.23 (1 − 0.4623)⁄ = −247.77 
قيام بالتحويلات فإننا نفقد قيمة المشاهدة الاولى لذا يقترح القيام بالتحويل التالي ال يلاحظ أنه بعد  :  ملاحظة-

 قيمة الاولى لكل المتغيرات: اللغرض ادخال  
𝐷𝑌 = 𝑌 − 0.4738 ∗ Y(−1) 
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 تعريفه، إختبارات الكشف عنه ومعالجتمه   HETEROSCEDASTICITYتلاف التباين  خإ-ثامنا

 
 تمهيد: 

فهم العلاقات بين المتغيرات والتنبؤ بالنتائج التي تستخدم لغرض    إن دقة نتائج التقدير في نماذج الانحدار 
. يعني هذا الافتراض أن تباين الأخطاء من بينها  تجانس التباينوالتي يعتبر  تعتمد بشكل كبير على افتراضات معينة،  

عندما يتم انتهاك هذا الافتراض، أي عندما   في النموذج يجب أن يكون ثابتا عبر جميع مستويات المتغيرات المستقلة.
لذا  ".  Heteroscedasticity  يكون تباين الأخطاء غير ثابت، فإننا نواجه مشكلة تعرف باسم "اختلاف التباين

يهدف هذا الفصل إلى استكشاف مشكلة اختلاف التباين بشكل شامل. سنبدأ بتوضيح مفهوم اختلاف التباين 
وأهميته في نماذج الانحدار. بعد ذلك، سنستعرض مجموعة من الاختبارات الإحصائية المستخدمة للكشف عن وجود 

 أمثلة تطبيقية كل ذلك مع تقدي لاف التباين،  اختلاف التباين، بالإضافة إلى ذلك، سنناقش طرقا مختلفة لمعالجة اخت
 وذلك من خلال العناصر التالية:  .اجراء تلك الاختباراتلتوضيح كيفية  

 . تعريفه أسبابه والنتائج المترتبة عنه في العنصر الأول  اختلاف التباين ▪
 . الاخطاء في العنصر الثانيتجانس تباين    اختبارات الكشف على عدم  ▪
 .في العنصر الثالث  الاخطاءتجانس تباين    مشكل عدم معالجة   ▪

 
 : النتائج المترتبة عنهو   أسبابه  تعريفه   اختلاف التباين  - 1

ليه في السابق واحد من أهم فروض نموذج الانحدار الخطي التقليدي، هو أن يكون تباين إكما تم الاشاره 
𝜎𝑢𝑡مقدار ثابت يساوي    𝑢𝑡مقدار الخطأ  

والتي   Homoscedasticityوهذا ما يسمى بفرضية ثبات التباين    2
 أي تساوي التباين  (Scedasticity)الانتشار   (Homo)نعني بها تساوي  

في المجتمع   .والذي نعني به أن يكون تباين الخطأ ثابتا عند كل قيم المتغير التفسيري ومساويا لتباين المتغير التابع   
 الاحصائي يعبر عنه كما يلي: 

𝐸(𝑢𝑡
2) = 𝜎𝑢𝑡

2  

هناك أسباب عديدة تجعل تباين الأخطاء متغيرا، بعض من هذه الأسباب أسباب مشكل إختلاف التباين: - 1- 1
 كالتالي: 
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عن   مثالو   تغير التباين مع المتغيرات المستقلة: قد يزداد تباين الأخطاء مع زيادة قيم المتغيرات المستقلة، أو قد يقل.-
في دراسة العلاقة بين الدخل والإنفاق، قد يزداد تباين الإنفاق مع زيادة الدخل، حيث يكون لدى الأفراد  ذلك  

 ذوي الدخول المرتفعة نطاق أوسع من خيارات الإنفاق. 

وجود قيم متطرفة: يمكن للقيم المتطرفة في البيانات أن تؤثر بشكل كبير على تباين الأخطاء، مما يؤدي إلى عدم -
 ثباته. 

عدم تجانس البيانات: قد تكون البيانات مأخوذة من مجموعات سكانية مختلفة ذات تباينات مختلفة، مما يؤدي -
 إلى عدم تجانس البيانات وبالتالي عدم ثبات تباين الأخطاء. 

 أخطاء القياس: قد تؤدي أخطاء القياس في المتغيرات التابعة أو المستقلة إلى زيادة تباين الأخطاء. -

 تجاهل متغيرات مهمة: قد يؤدي تجاهل بعض المتغيرات المستقلة المهمة في النموذج إلى زيادة تباين الأخطاء. -

تحويلات البيانات غير المناسبة: في بعض الحالات، يمكن أن يؤدي استخدام تحويلات غير مناسبة للبيانات إلى -
 عدم ثبات تباين الأخطاء. 

عدم ثبات تباين الأخطاء هو مشكلة شائعة في نماذج الانحدار الخطي، خاصة عند التعامل مع البيانات  ملاحظة: 
يمكن أن يؤدي عدم ثبات تباين الأخطاء إلى نتائج غير دقيقة في تقدير معاملات الانحدار واختبار إذ    المقطعية.

 الفرضيات.

يترتب على عدم ثبات تباين الاخطاء في النموذج كما  النتائج المترتبة عن وجود مشكل إختلاف التباين: - 2- 1
 المقدر النتائج التالية: 

العادية - الصغرى  المربعات  فإن طريقة  تباين الأخطاء غير ثابت،  للمعاملات: عندما يكون  فعالة  تقديرات غير 
(OLS)    لا تعطي أفضل تقديرات خطية غير متحيزة(BLUE) هذا يعني أن تقديرات المعاملات قد لا تكون .

 دقيقة قدر الإمكان. 

أخطاء معيارية متحيزة: يؤدي عدم ثبات التباين إلى تحيز في الأخطاء المعيارية لتقديرات المعاملات. هذا يعني أن -
الأخطاء المعيارية المقدرة قد تكون أصغر أو أكبر من الأخطاء المعيارية الحقيقية، مما يؤثر على اختبارات الفرضيات 

 وفترات الثقة. 
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( Fو    tاختبارات فرضيات غير صحيحة: نظرا لتحيز الأخطاء المعيارية، فإن اختبارات الفرضيات )مثل اختبارات  -
 قد تعطي نتائج غير صحيحة. قد يؤدي ذلك إلى رفض أو قبول فرضيات العدم بشكل خاطئ. 

فترات ثقة غير موثوقة: تعتمد فترات الثقة على الأخطاء المعيارية. وبالتالي، فإن تحيز الأخطاء المعيارية يؤدي إلى -
 فترات ثقة غير موثوقة. قد تكون فترات الثقة أضيق أو أوسع من اللازم، مما يؤثر على تفسير النتائج.

بشكل عام، يؤدي عدم ثبات التباين إلى نتائج مضللة. قد يبدو أن هناك علاقات مهمة بين المتغيرات عندما لا    
يقلل من موثوقية نتائج نموذج الانحدار الخطي، مما كما    تكون موجودة بالفعل، أو قد يتم تجاهل علاقات مهمة. 

 يجعل التنبؤات والاستنتاجات المستندة إلى النموذج غير دقيقة.

 : )إختلاف التباين(  لى عدم تجانس تباين الاخطاءاختبارات الكشف ع-2

ولغرض توضيح ذلك  الاختبارات الاحصائيةمختلف  تطبيق  وكذا    التمثيل البيان  اختبارات يتم ذلك من خلال    
 .Eviewsنأخذ المثال التالي مع التطبيق في برنامج  

الذي يمثل عدد الوحدات المنتجة   Yلتكن لدينا المعطيات التالية لبيانات مقطعية الخاص بالمتغير التابع  :07المثال 
فرع من فروع احدى المؤسسات )الوحدة: ألف   25الذي يمثل تكاليف الانتاج لــ    Xمن سلعة ما والمتغير المستقل  

 كما يلي:  2020دولار( في سنة  

i 1 2 3 4 5 6 7 8 9 10 11 12 

Y 2 2.7 2.7 2.5 2.8 4.1 3.5 3.8 4 2.9 5.2 5.3 

X 3.5 3.5 3.5 3.5 3.5 5 5 5 5 5 7 7 

13 14 15 16 17 18 19 20 21 22 23 24 25 

4 3.8 6.2 5.7 6.2 7.5 7.7 5 8.1 5.7 8.9 8.67 7 

7 7 7 8.5 8.5 8.5 8.5 8.5 10.5 10.5 10.5 10.5 10.5 

 المطلوب: 

 )في وجود الثابت(   ؟Y/Xقدر نموذج الانحدار لـــ  -01

 ختبار ثبات التباين في نموذج المقدر؟ با  قم  باستخدام مختلف الاختبارات الاحصائية-02

الاخطاء  - تباين  اختلاف  عن  الكشف  اختبارات  اجراء  بعض قبل  وتطبيق  البيان  الرسم  خلال  من  تتم  والتي 
 نقوم بتقدير نموذج الانحدار كما يلي: الاحصائية  الاختبارات  
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 تقدير نموذج الانحدار: -1

 
 من خلال التمثيل البياني:   اختبارات الكشف على عدم تجانس تباين الاخطاء  -2-1

 باستخدام شكل الانتشار بين بواقي النموذج المقدر والمتغير المستقل: -2-1-1

فإذا كانت نقاط الانتشار عشوائية لا تتخذ نمطا معيانا فذلك يعنى ثبات تباين الاخطاء أو عدم وجود مشكل  
  Residبعد قيامنا بتقدير نموذج الانحدار نتحصل على سلسلة بواقي النموذج المقدر    .عدم ثبات تباين الاخطاء

 كما يلي:   بين بواقي النموذج المقدر والمتغير المستقلبعد ذلك نقوم برسم شكل الانتشار  

 من خلال كتابة الامر التالي في مساحة الاوامر:

Scat x resid 

 نتحصل على ما يلي: 

 



 مقياس برمجيات احصائية  
 

 82 

نجري في حالة الانحدار الخطي البسيط  فالرسم البياني لانحدار مربعات البواقي على المتغير المستقل:  -2-1-2
البواقي على كل متغير مستقل على حدى في حالة الانحدار   عوانحدار مربانحدار مربع البواقي على المتغير المستقل  

 الخطي المتعدد. 

 وذلك من خلال الذهاب إلى: 

Quick→Graph 

 : في مربع الحوار الذي ظهر لدينا نكتب

X resid^2  
 كما هو مبين أدناه:   

 
من جديد نتحصل على الشكل   okوبالضغط على    Scatterومن مربع الحوار الذي يظهر نختار    okبالضغط على  

 التالي:
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بحيث يكون هناك مشكل   :𝒀̂الرسم البياني لانحدار مربعات البواقي على القيم المقدرة للمتغير التابع  -2-1-3

التالية تبين حالات وجود  عدم ثبات تباين الاخطاء إذا كانت هناك علاقة طردية )عكسية( بينهما، والاشكال 
 مشكل عدم ثبات التباين. 

 
 ويتم تنفيذ ذلك من خلال: 
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المقدر - المتغير  لقيم  سلسلة  الامر    𝒀̂ انشاء  خلال  ومن  التقدير  نافذة  بكتابة    Forecastففي  في   Yfنقوم 
Forecast name   :كما يلي 

 
 نجد أن البرنامج تم انشاء السلسة  في ملف العمل, وبعد ذلك نذهب إلى: okبالضغط على  

Quick→Graph 

 في مربع الحوار الذي يظهر لدينا نكتب كما هو مبين أدناه: 

 
من جديد نتحصل على   okوبالضغط على    Scatterومن مربع الحوار الذي يظهر نختار    okبالضغط على      

 الشكل التالي: 
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 : باستخدام الاختبارات الاحصائية  عدم تجانس تباين الاخطاءعن الكشف  -2-2

 فرضيات الاختبار هي كما يلي:

𝑯𝟎: 𝝈𝒖𝟏التباين ثابت )متجانس(: -
𝟐 = 𝝈𝒖𝟐

𝟐 = ⋯ = 𝝈𝒖𝒌
𝟐 = 𝝈𝒖

𝟐 

 واحد  على  الأقل من  التباينات  مختلف  عن  البقية  :𝑯𝟏التباين غير ثابت )غير متجانس(:  -

 : إلى  من نافذة التقدير نذهب  -

View→Residual Diagnostics→Heteroskedasticity Tests 

 نتحصل على مربع الحوار أدناه:
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 نحدد نوع الاختبار كما يلي:   Test typeمن خلال  -

يسمح اختبار جليسر بالكشف عن وجود مشكل عدم تجانس   :Glejser Test (1969)اختبار  -2-2-1
تباين ويسمح ايضا بتحديد الشكل الذي يبرز الظاهرة، ويستند هذا الاختبار إلى تحديد العلاقة بين بواقي نموذج  

المفترض أنه سبب عدم ثبات التباين )من خلال انحدار القيمة   jXالتقدير للنموذج الأساسي والمتغير التفسيري  
المطلقة للبواقي على المتغير المستقل وفقا لشكل معين لدالة الانحدار(، غير أنه يعاب هذا الاختبار على أنه قد لا 

لا تساوي الصفر،  تتوافر في حد الخطأ العشوائي قد لا تتوافر فيه افتراضات طريقة المربعات الصغرى )قيمته المتوقعة
لعشوائي(، ويقترح هذا الاختبار الاشكال التالية ليحدد نمط عدم عدم تجانس تباين والارتباط الذاتي بين الخطأ ا

 ثبات التباين كما يلي: 

 الشكل المقترح  نمط عدم ثبات التباين
𝜎̂𝑢
2 = 𝑘2𝑋1𝑡

2  |𝑒𝑡| = 𝛽0 + 𝛽1𝑋1𝑡 + 𝑣𝑡 
𝜎̂𝑢
2 = 𝑘2𝑋1𝑡 |𝑒𝑡| = 𝛽0 + 𝛽1𝑋1𝑡

0.5 + 𝑣𝑡 
𝜎̂𝑢
2 = 𝑘2𝑋1𝑡

−2 |𝑒𝑡| = 𝛽0 + 𝛽1𝑋1𝑡
−1 + 𝑣𝑡 

في النماذج السابقة معنوية فإن ذلك يدل على وجود مشكل عدم تجانس   𝛽1إذا كانت قيمة المقدرة للمعلمة    
 𝛽1التباين ويتم اختيار النموذج الذي لديه أكبر قيمة لاحصائية ستيودنت المقابلة للمعلمة 

 لتنفيذ ذلك في البرنامج من نافذة التقدير نذهب إلى: -

View→Residual Diagnostics→Heteroskedasticity Tests 

كما نحدد الشكل   Glejser Testنحدد نوع الاختبار    Test typeمن مربع الحوار الذي يظهر ومن خلال      
 حسب كل حالة كأن نكتب:   Regressorsالمناسب لعدم تجانس التباين ضمن  

X^.5    أوX^-1   أوX   

 وذلك وفقا لكل نموذج كما يلي:
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 نتحصل على النتائج التالية:  okبالضغط على  

 
 أو نكتب كما يلي:
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 نتحصل على النتائج التالية:  okبالضغط على  

 
 أو نكتب كما يلي:
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 نتحصل على النتائج التالية:  okبالضغط على  

 
معنوية في كافة النماذج وبالتالي   𝛽1ومن خلال النماذج الثلاثة أعلاه المقدرة نلاحظ أن قيمة المقدرة للمعلمة     

النموذج الذي لديه أكبر قيمة لاحصائية  التباين ونقوم باختيار  فإن ذلك يدل على وجود مشكل عدم تجانس 
للمعلمة   المقابلة  قيمة    𝛽1ستيودنت  النموذج الاول لان  𝑡𝑠𝑡𝑎𝑡𝑖𝑠𝑡𝑖𝑐]وهو  = النماذج   [3,36 هي الاكبر بين 

 .المقابلة للمعلمة المقدرة الثلالثة و 

يستخدم هذا الاختبار في العينات الكبيرة وكلما :  Breusch Pagan Goldfrey (1979)اختبار  - 2- 2- 2
كان حجم العينة اكبر زادت قوة هذا الاختبار، غير أنه حساس جدا في حالة عدم تحقق فرضية التوزيع الطبيعي 
للبواقي كما انه يتطلب معرفة سبب مشكلة عدم تجانس التباين من خلال نتائج الاختبار التي تظهر كما يلي ومن 
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𝛼وبمقارنته مع مستوى المعنوية    (F-Statistic)خلال قيمة الاحتمال المقابل لاحصائية الاختبار   = مثلا،   0.05
  : نحدد قرار الاختبار بخصوص رفض فرضية العدم )عدم تجانس التباين( فإذا كانت

𝑃𝑟𝑜𝑏(F − Statistic) < 𝛼 = 0.05 

 نرفض فرضية العدم ونقبل الفرضية البديلة بوجود مشكل عدم تجانس تباين الاخطاء 

 بالتطبيق عن مثالنا السابق نتحصل على نتائج الاختبار التالية:

 
 إذ يتبين أن: 

𝑃𝑟𝑜𝑏(F − Statistic) = 0.0056 < 𝛼 = 0.05 
 وبالتالي نرفض فرضية العدم أي أن هناك مشكل عدم تجانس تباين الاخطاء للنموذج المقدر 

لـــ   دو  لاختبار كي  المقابل  الاحتمال  خلال  من  العدم  فرضية  )رفض(  قبول  قرار  تحديد  يمكن  -Obs*Rكما 

squared    تجانس التباين( إذا كان:   نرفض فرضية العدمفإننا( 

𝑃𝑟𝑜𝑏(chi − square) < 𝛼 = 0.05 
 من خلال النتائج أعلاه يتبين أن: 

𝑃𝑟𝑜𝑏(chi − square) = 0.0072 < 𝛼 = 0.05 
 وبالتالي نرفض فرضية العدم أي أن النموذج المقدر يعان من مشكل عدم تجانس التباين الاخطاء

من مميزات هذا الاختبار أنه لا يعتمد على فرضية التوزيع الطبيعي للبواقي، إلا أنه   :Whiteاختبار  - 3- 2- 2
يصلح للعينات الكبيرة، ولإجراء هذا الاختبار بافتراض أنه لدينا متغيرين مستقلين في نموذج الانحدار نتبع الخطوات  

 التالية:

 :   𝜀𝑡تقدير نموذج الانحدار التالي والحصول على سلسلة البواقي -
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𝑌𝑡 = 𝛽0 + 𝛽1𝑋1𝑡 + 𝛽2𝑋2𝑡 + 𝜀𝑡 
 :  𝑅2تقدير نموذج الانحدار المساعد التالي وحساب قيمة معامل التحديد   -

𝜀𝑡
2 = 𝛽0 + 𝛽1𝑋1𝑡 + 𝛽2𝑋2𝑡 + 𝛽3𝑋1

2 + 𝛽4𝑋2
2 + 𝛽5𝑋1𝑡𝑋2𝑡 + 𝑣𝑡 

𝐿𝑀إذا كانت: - = 𝑛𝑅2 > 𝒳𝑘
 : يمثل عدد المتغيرات المستقلة المدرجة في نموذح الانحدار( k)حيث    2

 فإننا نرفض فرضية العدم التي تنص على ثبات تباين الاخطاء ونقر بعدم تجانس تباين الأخطاء للنموذج المقدر. 

 لتنفيذ ذلك في البرنامج من نافذة التقدير نذهب إلى: -

View→Residual Diagnostics→Heteroskedasticity Tests 

 okبالضغط على    Whiteنحدد نوع الاختبار وهنا نختار    Test typeمن مربع الحوار الذي يظهر ومن خلال      

 نتحصل على النتائج التالية: 

 
 ويتحدد قرار الاختبار بنفس الطريقة السابقة كما يلي: 

 من خلال الاحتمال المقابل لاختبار فيشر يتبين أن: -

𝑃𝑟𝑜𝑏(F − Statistic) = 0.0234 < 𝛼 = 0.05 
 وبالتالي نرفض فرضية العدم ونقر بوجود مشكل عدم تجانس تباين الاخطاء للنموذج المقدر 

 يتبين أن:   Obs*R-squaredمن خلال الاحتمال المقابل لاختبار كي دو لـــ  -

𝑃𝑟𝑜𝑏(chi − square) = 0.0269 < 𝛼 = 0.05 
 وبالتالي نرفض فرضية العدم ونقر بوجود مشكل عدم تجانس تباين الاخطاء للنموذج المقدر 
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 : معالجة مشكل عدم ثبات )تجانس( تباين الاخطاء  -3

 هناك طرق مختلفة لمعالجة مشكل عدم تجانس تباين الاخطاء نذكر منها ما يلي: 

وفقا لهذه الطريقة يتم   :Weighted Least Squares (WLS)طريقة المربعات الصغرى المرجحة  - 1- 3
معالجة مشكل عدم تجانس تباين الاخطاء من خلال اجراء تحويل للنموذج الاصلي بطريقة تجعل تباين الاخطاء 
متجانس ولتنفيذ ذلك لا بد من تحديد المتغير المستقل المسؤول عن حدوث مشكلة عدم تجانس تباين الاخطاء، 

ات التباين المكتشف في النموذج الاصلي )تحديد سبب مشكل عدم ويتوقف شكل النموذج المحول على نمط عدم ثب
 الذي يسمح بتحديد ذلك(، ويتم تنفيذ ذلك في برنامج كما يلي:   Glejserتجانس التباين وفقا لاختبار  

كما في - بعد تقدير نموذج الانحدار بطريقة المربعات الصغرى العادية السابق ونتحصل على النتائج التالية  -
 :-السابق

 
 من خلال نافذة النموذج المقدر نذهب إلى: 

Proc→Spesify∕Estimate 

 يظهر لنا ما يلي: 
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 نختار:   Optionsمن خلال مربع الحوار الذي أعلاه نذهب إلى  -

   Covariance methodفي خانة   Ordinaryنختار   Coefficient Covarianceمن خلال  -

 Weightفي خانة   X^.5/1كما نكتب   Typeفي خانة   Inverse std.devنختار  Weightsمن خلال  -

series   كما يظهر أدناه: )هنا وفقا لاختبار سبب مشكل عدم تجانس التباين وفقا لاختبارGlejser   الذي
 يسمح بتحديد ذلك هو النموذج الاول( 

 
 نتحصل على ما يلي:  okبالضغط على  

 
وفقا لهذه الطريقة   :Generalized Least Squares (GLS)طريقة المربعات الصغرى المعممة  -3-2

 يتم معالجة مشكل عدم تجانس تباين الاخطاء من خلال الخطوات التالية:
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تحديد قيمة تباين الاخطاء وبعد ذلك نقوم بقسمة حدود المعادلة للنموذج المقدر على قيمة الانحراف المعياري -
 للبواقي النموذج وبعد ذلك نقوم بتقدير النموذج باستخدام طريقة المربعات الصغرى كما يلي:

 من خلال نافذة النموذج المقدر نذهب إلى: 

Proc→Spesify∕Estimate 

 يظهر لنا ما يلي: 

 

 نختار:   Optionsمن خلال مربع الحوار الذي أعلاه نذهب إلى  -

   Covariance methodفي خانة   HC(various)نختار   Coefficient Covarianceمن خلال  -

في خانة  stdev(resid)@/1كما نكتب   Typeفي خانة   Inverse std.devنختار  Weightsمن خلال  -
Weight series  :كما يظهر أدناه 
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 نتحصل على ما يلي:  okبالضغط على  

 
 

وفقا لهذه الطريقة يتم تقدير النموذج باستخدام طريقة المربعات   :Whiteطريقة تصحيح الأخطاء المعيارية    -3-3
 الصغرى العادية كما فعلنا في السابق ثم من خلال نافذة النموذج المقدر نذهب إلى: 

Proc→Spesify∕Estimate 

 يظهر لنا ما يلي: 
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 نختار: Optionsمن خلال مربع الحوار أعلاه نذهب إلى  -

   Covariance methodفي خانة   Huber-Whiteنختار   Coefficient Covarianceمن خلال  -

 كما يظهر أدناه: 

 
 نتحصل على ما يلي:   okبالضغط على  
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مشكل عدم تجانس تباين الأخطاء في النموذج   لنأخذ مثالا ثان ونقوم بتنفيذ مختلف الخطوات السابقة لاكتشاف

 المقدر وكيفية معالجته. 

لاقتصاد ما خلال الفترة  (X) الدخلو   (Y)  الانفاق على الغذاءلتكن لدينا المعطيات التالية التي تمثل    :08المثال  
1984-2023.   

T 1984 1985 1986 1987 1988 1989 1990 1991 1992 1993 

X 3.69 4.39 4.75 6.03 12.47 12.98 14.2 14.76 15.32 16.39 

Y 115.22 135.98 119.34 114.96 187.05 243.92 267.43 238.71 295.94 317.78 

T 1994 1995 1996 1997 1998 1999 2000 2001 2002 2003 

X 17.35 17.77 17.93 18.43 18.55 18.8 18.81 19.04 19.22 19.93 

Y 216 240.35 386.57 261.53 249.34 309.87 345.89 165.54 196.98 395.26 

T 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 

X 20.12 20.33 20.37 20.43 21.45 22.52 22.55 22.86 24.2 24.39 
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Y 406.34 171.92 303.23 377.04 194.35 213.48 293.87 259.61 323.71 275.02 

T 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 

X 24.42 25.2 25.5 26.61 26.7 27.14 27.16 28.62 29.4 33.4 

Y 109.71 359.19 201.51 460.36 447.76 482.55 438.29 587.66 257.95 375.73 

 المطلوب: 

𝑌𝑡قدر نموذج الانحدار التالي: -1 = 𝛽0 + 𝛽1𝑋𝑡 + 𝑈𝑡 

 تأكد من وجود مشكل عدم تجانس تباين الأخطاء من خلال فحص سلسلة بواقي النموذج المقدر؟ -2

اختبار  -3 باستخدام  الأخطاء  تباين  تجانس  عدم  مشكل  وجود  اختبار  Glejser Testاختبر   ،Breusch 

Pagan Goldfrey  اختبار ،White ؟ 

 عدم تجانس تباين الأخطاء باستخدام كل من:   قم بمعالجة مشكل -4

 ؟ Weighted Least Squares (WLS)طريقة المربعات الصغرى المرجحة    -

 ؟ Generalized Least Squares (GLS)طريقة المربعات الصغرى المعممة  -

 الحل:

 تقدير نموذج الانحدار: - 

 
 : الكشف عن وجود مشكل عدم ثبات تباين الأخطاء من خلال فحص سلسلة البواقي    - 

 من خلال نافذة التقدير نذهب إلى: 
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View→ Actual, Fitted-Residual→ Residual Graph 

 يظهر لدينا الشكل التالي: 

 
يتبين من خلال الشكل أعلاه أن قيم البواقي النموذج المقدر تزداد بزيادة قيم الدخل فالمنحنى له أتجاه أكبر     

كلما كان عدد المشاهدات أكبر وذلك لأن المشاهدات مرتبة وفقا لزيادة في قيم الدخل، ومنه كلما كانت قيم 
اين وهذا ما يدل على وجود مشكل عدم ثبات تب الدخل كبيرة كلما كنت للبواقي قيم كبيرة )بالقيمة المطلقة( 

  الأخطاء في النموذج المقدر. 

 اختبار تجانس تباين الاخطاء:- 
 :  Breusch Pagan Goldfreyاختبار  -3-1 

 بالتطبيق عن مثالنا نتحصل على نتائج الاختبار التالية: 

 

 إذ يتبين أن: 

𝑃𝑟𝑜𝑏(F − Statistic) = 0.0057 < 𝛼 = 0.05 
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 لنموذج المقدر في اوبالتالي نرفض فرضية العدم أي أن هناك مشكل عدم تجانس تباين الاخطاء 

 : تعطى كما يليالاختبار  نتائج    :Whiteاختبار  -3-2 

 
 من خلال الاحتمال المقابل لاختبار فيشر يتبين أن: -

𝑃𝑟𝑜𝑏(F − Statistic) = 0.0208 < 𝛼 = 0.05 
 وبالتالي نرفض فرضية العدم ونقر بوجود مشكل عدم تجانس تباين الاخطاء للنموذج المقدر 

   :Glejser Testاختبار  -3-3 

  Regressorsكما نحدد الشكل المناسب لعدم تجانس التباين ضمن   Glejser Testنحدد نوع الاختبار  -
 حسب كل حالة كأن نكتب: 

X^.5    أوX^-1   أوX   

 وذلك وفقا لكل نموذج كما يلي:
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 نتحصل على النتائج التالية:  okبالضغط على  -

 
 أو نكتب كما يلي:

 
 نتحصل على النتائج التالية:  okبالضغط على  
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 أو نكتب كما يلي:

 
 نتحصل على النتائج التالية:  okبالضغط على  



 مقياس برمجيات احصائية  
 

 103 

 
معنوية في كافة النماذج وبالتالي   𝛽1ومن خلال النماذج الثلاثة أعلاه المقدرة نلاحظ أن قيمة المقدرة للمعلمة     

النموذج الذي لديه أكبر قيمة لاحصائية  التباين ونقوم باختيار  فإن ذلك يدل على وجود مشكل عدم تجانس 
𝑡𝑠𝑡𝑎𝑡𝑖𝑠𝑡𝑖𝑐]ن قيمة ول لأ وهو النموذج الأ 𝛽1ستيودنت المقابلة للمعلمة  =  .المقابلة للمعلمة المقدرة  [3,80
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 عنه ومعالجته ختبارات الكشف إالتعدد )الازدواج، الاشتراك، التداخل( الخطي:  -تاسعا

 

 : التعدد الخطي  تعريف-1
مصطلح إحصائي يشير إلى وجود علاقة خطية قوية بين متغيرين مستقلين   (Multicollinearity)  لتعدد الخطيا

أو أكثر في نموذج الانحدار. بعبارة أخرى، عندما يمكن التعبير عن أحد المتغيرات المستقلة كدالة خطية لمتغير مستقل 
 .خطيا بين هذين المتغيرين  آخر، فإننا نقول إن هناك تداخلا
 ؟ لماذا يعتبر التعدد الخطي مشكلة

 الخطي مشكلا لأنه يؤدي إلى:   عددعتبر التي

يؤدي التعدد الخطي إلى زيادة تباين معاملات الانحدار، مما يجعلها أقل دقة وأكثر  :عدم استقرار المعاملات •
 .حساسية للتغيرات الصغيرة في البيانات

يصعب تفسير المعاملات بشكل فردي، حيث يصعب تحديد تأثير كل متغير  :صعوبة تفسير المعاملات •
 .مستقل على المتغير التابع بشكل منفصل

قد يؤدي التعدد الخطي إلى قبول فرضية العدم الخاطئة، أي رفض  :زيادة احتمال الخطأ من النوع الثان •
 . متغير مستقل والمتغير التابع، حتى لو كانت العلاقة موجودة بالفعل  وجود علاقة بين 

 التعدد الخطي يظهر نتيجة الاسباب التالية:  :التعدد الخطيمشكل    أسباب-2

البيانات • الدخل  :طبيعة  مثل  طبيعي،  بشكل  مترابطة  متغيرات  على  تحتوي  نفسها  البيانات  تكون  قد 
 .والاستهلاك

 .قد يؤدي تضمين متغيرات متشابهة أو متكررة في النموذج إلى حدوث التعدد الخطي :نمذجة غير مناسبة •
 . قد يؤدي حجم العينة الصغير إلى تضخيم تأثير التعدد الخطي: حجم العينة الصغير •

 :كن تصنيف التعدد الخطي إلى نوعين رئيسيينيم  :التعدد الخطي  أنواع-3

كون هناك علاقة تعندما    هذا النوع  ظهري:  (Perfect Multicollinearity)  التعدد الخطي الكامل - 1- 3
دقيقة   المتغيرات كتركيبة خطية  أحد  عن  التعبير  يمكن  أكثر، بحيث  أو  مستقلين  متغيرين  بين  مثالية  لباقي خطية 
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نتيجة  لمتغيراتا أو يظهر  المعلومات مفردة .  تقدير معاملات الانحدار، حيث تصبح مصفوفة  القدرة على   عدم 
(Singular) 

عندما يكون هناك هذا النوع  يحدث :   (Imperfect Multicollinearity)التعدد الخطي الجزئي- 2- 3
، مما يجعل من مرتفع   تباين معاملات الانحدار  أو يكون .ارتباط خطي قوي ولكنه غير مثالي بين المتغيرات المستقلة

  .الصعب تفسير نتائج التحليل

 التعدد تتمثل النتائج الرئيسية المترتبة على وجود مشكلة  :  التعدد الخطيوجود مشكل   النتائج المترتبة عن -4
 في نماذج الانحدار الخطي المتعدد في:  (Multicollinearity)  الخطي

 المعيارية  الأخطاءو   (Variances)  تباينات تصبح    المقدرة:   المعاملات   أخطاء  و   تباينات   زيادة ▪
(Standard Errors  )مقداراتلـ  (Estimates)    أي تكون التقديرات   جدا  كبيرة معلمات الانحدار(

، حيث تفقد خاصية كونها (OLS)مقدرات المربعات الصغرى العادية    كفاءةهذا يقلل من  و   غير دقيقة(.
 ممكن.   تباين  أقل صاحبة  

 ستيودنت   إحصائيةسبب كبر الأخطاء المعيارية، تنخفض قيمة  ي  الإحصائية:   الدلالة   اختبارات  فشل ▪
إلى   غالبا  يؤدي  الفرضية (  Insignificant)  معنوية  عدم مما  )قبول  المقدرة  الانحدار  معاملات  معظم 

الصفرية التي تنص على أن المعامل يساوي صفرا(، حتى لو كان للمتغيرات المستقلة تأثير حقيقي على 
 المتغير التابع. 

، جدا  واسعةلمعاملات الانحدار  (  Confidence Intervals)  الثقة  فتراتتصبح    الثقة:  فترات   اتساع ▪
 مما يجعل تحديد القيمة الحقيقية للمعاملات صعبا وغير دقيق.

من    المعاملات:   تفسير  في   صعوبة  ▪ على   فصل  جدا  الصعب يصبح  مستقل  متغير  لكل  الفردية  الآثار 
لبعض المعاملات   (Signs)  مخالفة   إشارات قد تظهر  ف  المتغير التابع بسبب ارتباطها القوي ببعضها البعض. 

 المقدرة عن التوقعات النظرية أو المنطقية. 
في البيانات )مثل إضافة  بسيط تغير لأي  جدا  حساسةتكون تقديرات المعاملات   التقديرات:  حساسية ▪

 أو حذف مشاهدة واحدة( أو لتغيير في مواصفات النموذج )مثل إضافة أو حذف متغير مستقل آخر(. 
 معامل  قيمةمن الملاحظات الشائعة أنه قد تكون    المعاملات:  معنوية   عدم  مع  مرتفع  التحديد  معامل  ▪

من التباين في المتغير التابع(، ولكن في   ا)مما يشير إلى أن النموذج ككل يفسر جزءا كبير   عالية  التحديد
 .معنوية  غير   ستيودنت اختباراتالمقابل تكون معظم  

 : التعدد الخطيعن مشكل   اختبارات الكشف-5
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 ,X1, X2, X3وبعض المتغيرات المفسرة    Yلمتغير التابع  التكن لدينا المعطيات التالية التي توضح      :09المثال  
X4  كما هو مبين ادناه : 

Model X1 X2 X3 X4 Y 

1 11600 846 32 650 5.7 

2 12490 993 39 790 5.8 

3 10450 899 29 730 6.1 

4 17140 1390 44 955 6.5 

5 14825 1195 33 895 6.8 

6 13730 658 32 740 6.8 

7 19490 1331 55 1010 7.1 

8 25000 1597 74 1080 7.4 

9 22350 1761 74 1100 9 

10 36600 2165 101 1500 11.7 

11 22500 1983 85 1075 9.5 

12 31580 1984 85 1155 9.5 

13 28750 1998 89 1140 8.8 

14 22600 1580 65 1080 9.3 

15 20300 1390 54 1110 8.6 

16 19900 1396 66 1140 7.7 

17 39800 2435 106 1370 10.8 

18 19740 1242 55 940 6.6 

19 38990 2972 107 1400 11.7 

20 50800 2958 150 1550 11.9 

21 36200 2497 122 1330 10.8 

22 47700 2496 125 1670 11.3 

23 36950 1998 89 1560 10.8 

24 26950 1997 92 1240 9.2 

25 36400 1984 85 1635 11.6 

26 50900 2438 97 1800 12.8 

27 49300 2473 125 1570 12.7 

 

 الحل:

 : كما يلي نقوم بتقدير النموذج الانحدار الخطي المتعدد-1
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 قاعدة حساب معاملات الارتباط الجزئية بين المتغيرات المفسرة: قاعدة أولى: -5-1

 نتبع الخطوات التالية:   ايجاد مصفوفة معاملا ت الارتباط الجزئيةولغرض  

open→as group→ok 

view →covarionce analysis →correlation  
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 القاعدة الثانية: قاعدة التوافق في الاشارات: - 2- 5

نعلم أن اشارة معامل الارتباط بين المتغير التابع والمتغير المستقل هي نفس اشارة معامل الانحدار أو اشارة المعلمة 
قيم معاملات الارتباط بين كل متغير مستقل والمتغير اشارات  المقدرة )معامل ميل(، ومن مثالنا السابق نقوم بايجاد  

 معلمة مقدرة: كل  التابع ونقوم بمقارنتها باشارة  

لغرض ايجاد قيمة معامل الارتباط بين المتغير المستقل الاول والمتغير التابع نقوم بتضليل السلستين معا ثم نذهب 
 إلى: 

Quick→group statistics→correlation 

 ونتصحل على مايلي: 

 
 نتحصل على قيمة معامل الارتباط بين المتغيرين  كما يلي:   okبالضغط على  
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وبنفس الطريقة نجد قيم باقي معاملات الارتباط بين المتغير التابع وباقي المتغيرات المستقلة، كما يمكن ايجاد مصفوفة    
معاملات الارتباط بين كل من المتغير التابع وباقي المتغيرات المستقلة ونقوم باستخراج قيم معاملات الارتباط المعنية 

 كما يظهر ادناه: 

 
 ونلخص ذلك في الجدول التالي مع اضافة قيم معالم المقدرة لغرض المقارنة بين الاشارات: 

Y 

𝑟𝑦𝑥 𝛽̂𝑗  
0.942 0.000034 X1 

0.908 0.001208 X2 

0.888 -0.0037 X3 

0.944 0.0037 X4 

موجبة غير أن اشارة معامل الميل جاءت سالبة،  𝑟𝑌,𝑋3من خلال الجدول أعلاه نلاحظ أن اشارة معامل الارتباط  
 .وهذا يدلنا على وجود مشكل التعدد الخطي في النموذج المقدر

 VIFالقاعدة الثالثة: معامل تضخيم التباين - 3- 5

 كما يلي:  VIFبحساب قيم معامل تضخيم التباين    Eviewsنقوم من خلال برنامج  

 : نذهب إلىالنموذج  من نافذة تقدير    

view →Coefficient diagnostics →Variance inflation factors 
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 Centered)للنموذج يحتوى على ثابت    VIFنلاحظ من الجدول اعلاه المتحصل عليه الذي يحتوى على قيم      

VIF)    وقيمVIF    لنموذج لا يحتوى على ثابت(Uncentered VIF) 

في العمود الاخير للجدول كما تظهر   VIFوالنموذج المقدر الذي لدينا به الحد الثابت وبالتالي فنقوم بقراءة قيم     
وهذا يدل على وجود التعدد الخطي في النموذج   10لجميع المتغيرات أكبر من    VIFباللون الأصفر، ونلاحظ أن قيم  

 المقدر. 

 نعتمد على الطرق أدناه لمعالجة ذلك. :  التعدد الخطي  مشكل   معالجة-6

   AICالاختيار الامثل لمتغيرات عن طريق معيار  - 1- 6

 : Backward Elimination Methodباستخدام طريق الذهاب إلى الخلف  -1- 1- 6

 كما يلي: AICمعيار   نقوم بتقدير النموذج بادراج كل المتغيرات المستقلة ونقوم باستخراج قيمة •
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( ونقوم X1نقوم بتقدير النموذج بحذف متغير تفسيري واحد في كل خطوة مثلا )في بداية نحذف متغير   •
 وهكذا ونتحصل على النماذج التالية: AICمعيار   باستخراج قيمة

  

  
ذا حذفناه من النموذج يجب أن إولا من النموذج وهو المتغير الذي أ نقوم بتحديد المتغير الذي يخرج    بعد ذلك     

 للنموذج ككل.  AICمعيار   له أقل من قيمة AICتكون قيمة معيار 

  2,074تساوي   AICمعيار   ن عند حذفه تكون قيمةلأ  X3: المتغير الذي يخرج أولا هو  ففي المرحلة الأولى
 2.1454للنموذج ككل والتي تساوي   AICقل من قيمة معيار أوهي  

قل أوهي    2,023تساوي   AICمعيار   ن عند حذفه تكون قيمةلأ   X1المتغير الذي يخرج هو    : في المرحلة الثانية
 2,074للنموذج ككل والتي تساوي   AICمن قيمة معيار  

  2,023لنموذج ككل والتي تساوي  اله أكبر من    AICمعيار    عند حذف أي متغير نجد أن قيمة  :في المرحلة الثالثة  
 النموذج الذي يحتوي علىهو  ومنه في هذه المرحلة لا نقوم بحذف أي متغير ومنه النموذج الأمثل في هذه الحالة  

  خيص كل ذلك في الجدول أدناه:  ل، ونقوم بتX4  و X2تغير  الممتغيرين تفسيرين ممثلين في كلا من  
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 المرحلة  النموذج AICقيمة  حالة حذف المتغير  في AICقيمة 
X1 :2,096 

X2 :2,191 

X3 :2,074 

X4 :2,389 

2.1454 Y (C, X1, X2, X3, X4) 1 

X1 :2,023 

X2 :2,185 

:2,343 X4 

2,074 )X4, X2, X1(C,  Y 2 

X2 :2,345 

:2,827 X4 
2,023 Y (C, X2, X4) 3 

 مثل هو:ومنه النموذج المقدر الأ

 
 :Forwad Selection Methodباستخدام طريق الذهاب إلى الأمام -2- 1- 6

في هذه الطريقة نقوم بتقدير النموذج للمتغير التابع وكل متغير تفسيري على حدى في المرحلة الأولى نقوم بتحديد 
معيار   لكل نموذج وهنا لدينا أربعة متغيرات مفسرة إذن نقوم بتقدير أربعة نماذج ونستخرج  قيمة  AICمعيار    قيمة

AIC  .لكل نموذج 

ومما سبق   وهو المتغير الذي يدخل للنموذج أولا   AICلمعيار    : نحدد المتغير الذي له أقل قيمةففي المرحلة الأولى
   . X4إذن المتغير الذي يدخل للنموذج أولا هو   2,345تساوي  AICأقل قيمة معيار  
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  AICنقوم بادخال الى النموذج باقي المتغيرات المفسرة كل على حدى ونستخرج قيمة معيار    : في المرحلة الثانية
  والنموذج ذي أقل قيمة هو الذي نختفظ به مقارنة بالنموذج المقدر في وجود المتغير الذي ادخل اولا وهنا اقل قيمة  

 .X2إذن المتغير الذي يتم ادخاله إلى النموذج هو   2,34وهي اقل من   2,023تساوي   AICلمعيار  

أكبر من   AICتكون قيمة معيار    X3أو    X1في هذه المرحلة نلاحظ أنه عند ادخال متغير    :في المرحلة الثالثة
" إذن في هذه المرحلة لا نقوم بادخال أي متغير، ومنه النموذج   X4 " و "X2 قيمة معيار للنموذج السابق في وجود "

 خيص كل ذلك في الجدول أدناه: ل، ونقوم بتX4  و  X2الأمثل في هذه الحالة النموذج الذي يحتوي على متغيرين  

 المرحلة  النموذج AICقيمة  حالة اضافة المتغير  في AICقيمة 
X1 :2,382 

X2 :2,827 

X3 :3.019 

X4 :2,345 

/ / Y (C) 1 

X1 : 2,185 

X2 : 2,023 

:2,149 X3 

2,345 )X4(C,  Y 2 

X1 :2,074 

:2,096 X3 
2,023 CONS (C, POIDS, CYL) 3 
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 الكشف عن المركبة الفصلية، طرق نزع الفصلية  -عاشرا

يعد تحليل السلاسل الزمنية أداة أساسية في فهم البيانات التي تتغير بمرور الوقت، حيث تظهر هذه البيانات  :تمهيد
المركبة  الأنماط، تبرز  والتنبؤات. من بين هذه  التحليلات  تؤثر بشكلٍ كبير على دقة  أنماطا وتغيرات موسمية  غالبا 

 كثر دقة وموثوقية.الفصلية كعنصر حاسم يجب فهمه وإزالته لتحقيق نتائج أ
الزمنية وأهم مكوناتها ثم المركبة الفصلية في السلاسل      لذا يهدف هذا الفصل إلى استكشاف مفهوم السلسلة 

هنا  الزمنية همنا  الذي  وهو  الزمنية  السلسلة  مكونات  سنتناول كأحدى  وإزالتها.  عنها  الكشف  أهمية  وتوضيح   ،
بالتفصيل الطرق المختلفة للكشف عن هذه المركبة، سواء كانت طرقا تحليلية أو إحصائية، بالإضافة إلى استعراض 

وذلك بالتطرق للعناصر   أساليب نزع الفصلية الشائعة التي تستخدم لتنقية البيانات من تأثيرات التغيرات الموسمية. 
 التالية:
 في العنصر الأول.   السلسلة الزمنية   مفهوم  ▪
 ركبة الفصلية للسلسة الزمنية في العنصر الثاني.المتعريف   ▪
 ركبة الفصلية للسلسة الزمنية في العنصر الثالث.المالكشف عن   ▪
 ركبة الفصلية للسلسة الزمنية في العنصر الرابع.المطرق إزالة   ▪

 
نحاول من خلال هذا العنصر التطرق لتعريف السلسلة الزمنية والتطرق لأهم مكوناتها :  السلسلة الزمنية   مفهوم  -1

 وأهمية وأهداف استخدام السلاسل الزمنية في التحليل كما يلي:

 : السلسلة الزمنيةتعريف  - 1- 1

السلسلة الزمنية هي مجموعة من المشاهدات التي تُسجل بالتتابع خلال فترة زمنية محددة. وتتميز أي سلسلة 
زمنية بأن بياناتها مرتبة ترتيبا زمنيا، وأن المشاهدات فيها غالبا ما تكون غير مستقلة، أي أنها تعتمد على بعضها 

التنبؤ بالقيم المستقبلية. كما يستخدم الترتيب الزمني للإشارة البعض. يستغل هذا الاعتماد الزمني بين المشاهدات في  
 .إلى تسلسل المشاهدات

مجموعة من البيانات أو القيم التي يتم تسجيلها على مدار فترة زمنية علا أنها  السلسلة الزمنية  كما يمكن تعريف  
معينة، وبترتيب زمني محدد. يمكن أن تكون هذه البيانات متعلقة بأي متغير قابل للقياس، مثل المبيعات الشهرية، أو 
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أسعار الأسهم اليومية، أو درجات الحرارة السنوية. كما يمكن تعريفها على أنها مجموعة من المعطيات لظاهرة ما 
 مشاهدة عبر الترتيب التصاعدي للزمن. 

بين التمييز  المهم  الزمنية  العملية ومن  السلسلة  تولد  القيم   وبين  (Time Series Process) التي 
شاهدة

ُ
 وإن .  السلسلة  عملية   من  تولدت  التي   القيمة   للسلسلة. فالسلسلة الزمنية المشاهدة هي    (Realization) الم

 وصف   إلى   الزمنية   السلاسل  تحليل   ويهدف .  واحدة  مشاهدة  وليس   النظرية  المشاهدات   جميع  تعني   « قيمة»  كلمة 
 . لخصائص العملية نفسها  مشابهة  خصائص   له  مشاهد  نموذج  صيغة  في   السلسلة منها   تتولد  التي   النظرية  العملية

تكون مشاهدات السلسلة الزمنية تابعة للزمن الذي يحدد خاصيتها وتلك العلاقة الزمنية تأخذ اشكالا مختلفة،    
إذ عادة ما تكون السلسلة الزمنية ذات إتجاه واحد منتظم حيث يتكرر دوريتها بنفس الصيغة كل وحدة زمنية، أو 

الزمنية التي يتطلب منا   ذات تغير عشوائي لعناصر مرتبطة ذاتيا، وعموما نقصد بذلك العناصر المكونة للسلسلة 
 .معرفتها وتحديد مقدار تغييرها حتى يتسنى لنا القيام بالتقديرات اللازمة والتنبؤات الضررورية 

 : التاليةالعناصر  السلسلة الزمنية تتكون من    العناصر المكونة للسلسلة الزمنية: - 2- 1

   :(Trend)  العام  الاتجاه- 1-2-1
o  .يمثل الاتجاه العام الحركة طويلة الأجل للبيانات، سواء كانت تصاعدية أو تنازلية أو ثابتة 

o  .يعكس الاتجاه العام التغيرات الأساسية في البيانات على مدى فترة زمنية طويلة 

   (:Variations Cyclical)  الدورية   التغيرات- 1-2-2
o  تمثل التغيرات الدورية الأنماط المتكررة التي تحدث في البيانات على فترات زمنية أطول من

 التغيرات الموسمية، مثل الدورات الاقتصادية. 

o  .تعكس التغيرات الدورية تأثير العوامل الاقتصادية أو الاجتماعية على البيانات 

   (:Variations Irregular)  العشوائية   التغيرات- 1-2-3
o .تمثل التغيرات العشوائية التقلبات العشوائية أو غير المتوقعة في البيانات 

o  .تعكس التغيرات العشوائية تأثير الأحداث العرضية أو غير المنتظمة على البيانات 

 وأخير التغيرات الموسمية والتي سنتطرق لها بشكل من التفصيل لأنها هي المعنية بالدراسة في هذا الفصل. 

 

 المستخدمة  الطرق  تحديد   إلى   زمنية  سلسلة   أية  دراسة  أسباب  تؤدي   ما  غالبا   :الزمنية  السلاسل  تحليل   أهداف- 3- 1
 وهي:   الزمنية  السلاسل  دراسة  أهداف   لبعض   عامة   نظرة   إعطاء يستحسن  لذا،  .دراستها  في
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o الزمنية  السلسلة   منها تتولد   التي   للعملية   الخاصة  للملامح   دقيق  وصف  على   الحصول. 
o سلوك  قواعد   ببعض   المشاهدة  القيم  تربط  أخرى  متغيرات  بدلالة   السلسلة  سلوك  وشرح  لتفسير  نموذج  إنشاء 

 .السلسلة
o وذلك  المستقبل  في   السلسلة   بسلوك  للتنبؤ  الزمنية  السلاسل  تحليل   من   عليها  نحصل   التي  النتائج  استخدام 

  .الماضي   معلومات  على  اعتمادا
 

 الزمنية:  السلاسل   تحليل   أهمية- 4- 1
 

o  .التنبؤ بالمستقبل: يمكن استخدام تحليل السلاسل الزمنية للتنبؤ بالقيم المستقبلية للبيانات 
o .فهم الأنماط: يمكن استخدام تحليل السلاسل الزمنية لفهم الأنماط والاتجاهات في البيانات 
o  .اتخاذ القرارات: يمكن استخدام تحليل السلاسل الزمنية لاتخاذ قرارات مستنيرة بناءً على البيانات التاريخية 

 

تحليل السلاسل الزمنية يتطلب صياغة نموذج رياضي يحدد العلاقة بين قيم   النماذج العامة للسلسلة الزمنية:- 5- 1
 :المشاهدات ومركبات السلسلة الزمنية. يوجد نموذجان شائعان للاستخدام

يفترض هذا النموذج وجود علاقة **جمعية** بين   :  (Additive Model) النموذج التجميعي - 1- 5- 1
   بحيث تكون كل مركبة مستقلة عن الأخرى. يعبر عنه رياضيا بالمعادلةالتالية: 𝑌𝑡مركبات السلسلة الزمنية 

𝑌𝑡 = 𝑇𝑡 + 𝐶𝑡 + 𝑆𝑡 + 𝜀𝑡 

   :حيث
: 𝑇𝑡   الاتجاه العامتمثل (Trend)   

𝐶𝑡  :  التغيرات الدورية تمثل (Cyclical)   

: 𝑆𝑡التغيرات الموسمية (Seasonal)   

𝜀𝑡  :الخطأ العشوائي (Random Error)   

 .هي مجموع جميع المركبات  سلسلة الزمنيةفي هذا النموذج، تكون قيمة ال 
يفترض هذا النموذج وجود علاقة :    (Multiplicative Model) النموذج الجدائي أو المضاعف-2- 5- 1

  التالية:بالمعادلةعن هذا النموذج  رياضيا    ، مع وجود ارتباط بينها. يعبر 𝑌𝑡 **ضربية** بين مركبات السلسلة الزمنية
𝑌𝑡 = 𝑇𝑡 × 𝐶𝑡 × 𝑆𝑡 × 𝜀𝑡 

 

   ويمكن تمييز في هذا النموذج إلى نوعينمن النماذج:
 ويكتب من الشكل:  الجدائي المختلط:  شكلال-

𝑌𝑡 = 𝑇𝑡 × 𝐶𝑡 × 𝑆𝑡 + 𝜀𝑡 

 ويكتب من الشكل:   :تامالجدائي ال  شكلال-
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𝑌𝑡 = 𝑇𝑡 × 𝐶𝑡 × 𝑆𝑡 × 𝜀𝑡 

بسط تلك الأساليب أهناك العديد من الأساليب الاحصائية للكشف عن نوع نموذج الذي تتبعه السلسلة الزمنية وإن  
هو الشكل البيان للسلسلة، فإذا كان منحنى السلسلة الزمنية محصور بين خطين متوازيين نقول أن السلسلة من 
الشكل التجميعي، أما إذا كان منحنى السلسلة الزمنية محصور بين خطين منفرجين أو غير متوازيين إذ تظهر قيم  

الزمن ففي هذه الحالة نقول أن السلسلة من النوع الجدائي، والشكلين   السلسلة بوجود تذبذبات في تطور قيمها مع
 أدناه يوضحان ذلك: 

 

 
 

الشكل العام للسلسلة الزمنية من خلال التمثيل البيان لها، لذلك يتم    غير أنه على العموم يصعب تحديد 
 الاعتماد على مجموعة من الاختبارات الاحصائية والتي نتطرق لها لاحقا. 

الزمنيةالمتعريف  -2 للسلسة  الفصلية  عليها  :  ركبة  يصطلح  الموسية أيضا  كما  Seasonal )  بالتغيرات 

Variations)  تمثل الأنماط المتكررة التي تحدث في البيانات على فترات زمنية منتظمة، مثل الفصول أو الأشهر   والتي
وكمثال عن تلك التغيرات الاقبال  تعكس تأثير العوامل الموسمية على البيانات.. إذ S، ...ويرمز لها بالرمز  أو الأيام

على نوع من الألبسة أو سلعة ما في فصل ما. زيادة استهلاك الغاز في فصل الشتاء مقارنة بالفصول الأخرى، زيادة 
 الطلب على الحجوزات الفندقية في فصل الصيف، ...الخ.

 والشكل أدناه يبين وجود المركبة الفصلية في السلسلة الزمنية كما يلي: 
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 المركبة الفصلية في السلسلة الزمنية يمثل  الشكل  

 
 
  :ركبة الفصلية للسلسة الزمنيةالم الكشف عن  -3

، وغيرها...أسبوعية، شهرية أو كل ثلاثة أشهمرقد تكون  فالتغيرات الموسمية تحدث في فترات زمنية لا تفوق السنة،  
ويقصد بتقدير التأثيرات الموسمية: معرفة قيم الظاهرة لو لم تتأثر إلا بالمتغير الموسمي فقط، أي تقدير قيمة الظاهرة بعد 

 استبعاد كل العوامل المؤثرة الأخرى. 

 يتم الكشف عن التغيرات الموسمية وحسابها بعدة طرق، أهمها:

 طريقة النسب الموسمية )متوسطات كل موسم(  •
 طريقة النسبة إلى الاتجاه العام.  •
 طريقة النسبة إلى المتوسطات المتحركة. •

 :التاليةلخطوات  وفقا لهذه الطريقة تم ت  طريقة النسب الموسمية )متوسطات كل موسم(:-3-1

حساب متوسط قيم كل موسم من مواسم السلسلة الزمنية بغض النظر عن كون الموسم ربع سنة أو شهر   أولا/ -
 أو أسبوع....إلخ: 

𝑋̅ = 𝛴𝑋𝑖 𝑛⁄  



 مقياس برمجيات احصائية  
 

 119 

 : كما يلي  ثانيا/ حساب متوسط المتوسطات-

𝑋̿ =
𝑋̅1 + 𝑋̅2+. . . +𝑋̅𝑛

𝑛
 

 : حيث  :( النسب)ثالثا/ حساب التغير الموسمي عن طريق الانحرافات  -

 كما يلي:   يحسب بطرح متوسط المتوسطات من متوسط كل موسم  : (𝐷𝑖)التغير عن طريق الانحرافات   •

𝐷𝑖 = 𝑋̅𝑖 − 𝑋̿ 

يحسب عن طريق قسمة متوسط كل موسم على متوسط المتوسطات، ثم نضرب   : (𝑃𝑖)التغير النسبي   •
 الناتج في مائة. 

𝑃𝑖 =
𝑋̅𝑖
𝑋̿
⁄ × 100 

 : التالي  ثال لتوضيح ذلك نأخذ الم

 بآلاف الوحدات   (2022- 2019)الإنتاج الموسمي لأحد المصانع خلال الفترة  البيانات أدناه تمثل      :10المثال  
 ونقوم بتطبيق طريقة النسب الموسمية لتقدير المركبة الموسمية. 

 السنة      
 الموسم  

2019 2020 2021 2022 

 96 94 80 90 الموسم الأول 

 90 86 82 78 الموسم الثاني 

 80 84 76 80 الموسم الثالث 

 94 82 96 88 الموسم الرابع 

 الحل:
 كل موسم من مواسم السلسلة:   ةحساب متوسط قيم-1

𝑋̅1 =
90 + 80 + 94 + 96

4
= 90 
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𝑋̅2 =
78 + 82 + 86 + 90

4
= 84 

𝑋̅3 =
80 + 76 + 84 + 80

4
= 80 

𝑋̅4 =
88 + 96 + 82 + 94

4
= 90 

 حساب متوسط المتوسطات:-2

𝑋̿ =
𝑋̅1 + 𝑋̅2+. . . +𝑋̅𝑛

𝑛
=
90 + 84 + 80 + 90

4
= 86 

 : حساب التغير الموسمي-3
 باستخدام طريقة الانحرافات:-3-1

 (𝑋̅𝑖) وسمالم متوسط   (𝑋̿) متوسط المتوسطات (𝐷𝑖)  التغير الموسمي

 90 86 4 في الموسم الأول 

 84 86 2- في الموسم الثاني 

 80 86 6- في الموسم الثالث

 90 86 4 في الموسم الرابع 

 
 باستخدام طريقة النسب المؤوية: -3-2

𝑃𝑖 = 𝑋̅𝑖 𝑋̿ × 100⁄  
 مثلا في الموسم الأول: 

𝑃1 = 𝑋̅1 𝑋̿ × 100⁄ =
90

86
× 100 = 104,65 

 
 (𝑋̅𝑖) وسمالم متوسط   (𝑋̿) متوسط المتوسطات (𝑃𝑖)  التغير الموسمي

 90 86 104,65 في الموسم الأول 

 84 86 97,67 في الموسم الثاني 
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 80 86 93,02 في الموسم الثالث

 90 86 104,65 في الموسم الرابع 

 ومنه مجموع النسب الموسمية يساوي:  

𝛴𝑃𝑖 = 104,65 + 97,67 + 93,02 + 104,65 = 399,99 = 400 

تساوي  ف الأربعة  الموسمية  النسب  متساوية من حيث 400مجموع  المواسم كلها  إذا كانت  أنه  يدل على  ، وهذا 
 ويساوي:  متوسط كل موسم يساوي المتوسط العامفالإنتاج، فإن التغيرات الموسمية تكون معدومة. ومنه  

400

4
= 100 

تقريبا أن متوسط الإنتاج في هذا الموسم يزيد عن المتوسط العام  ناه  عم%:  106,97  تساوي   النسبة الموسمية الأولىف-
 وحدات من الإنتاج.  7أي ما يعادل  %، 7بـــ  

%،  3.49وهذا يعني أن متوسط الإنتاج في هذا الموسم يقل عن المتوسط العام بـ  %:  96.51النسبة الموسمية الثانية  -

 وحدات من الإنتاج.   3أي ما يعادل  

%،  8.10وهذا يعني أن متوسط الإنتاج في هذا الموسم يقل عن المتوسط العام بـ  %:  91.90النسبة الموسمية الثالثة  -

 وحدات من الإنتاج.   7أي ما يعادل  

،  % 4.65وهذا يعني أن متوسط الإنتاج في هذا الموسم يزيد عن المتوسط العام بـ  %:  104.65النسبة الموسمية الرابعة  -
 وحدات من الإنتاج.   4أي ما يعادل  

إذا ما جمعنا النقص والزيادة في متوسطات النسب عن المتوسط العام أو مجموع الانحرافات يكون الناتج مع العلم أنه  
 صفر.

الموسمية. نقسم   أثر التغيرات  من   الظاهرة تخليص قيم  إذا أردنا إيجاد القيم اللاموسمية، أي   : ستبعاد الأثر الموسميإ
 قيمة الظاهرة الحقيقية على النسبة المقابلة لها، أي: 
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𝑋𝑖𝑗
𝑃𝑖
× 100 

 . يثر الموسمالأ  خالية من فنحصل على قيمة الظاهرة  

 ستبعاد الأثر الموسمي. إبالعودة للمثال السابق، أوجد القيم بعد    :11المثال  

 الحل:

 السنة      
 الموسم  

التغير  
   الموسمي
(𝑷𝒊) 

الأثر   منزوعةسلسلة  2019

 2019الموسمي في 
سلسلة  2020

 منزوعة

الأثر 

الموسمي  

 2020في 

سلسلة  2021

 منزوعة

الأثر 

الموسمي  

 2021في 

20

22 

سلسلة 

 نزوعةم

الأثر 

الموسمي  

 2022في 
90 90 104,65 الموسم الأول  × 100

104,65
= 86 

80 76,44 94 89,82 96 91,73 

78 78 97,67 الموسم الثاني  × 100

97,67
= 79,86 

82 83,95 86 88,05 90 92,14 

80 80 93,02 الموسم الثالث  × 100

93,02
= 86 

76 81,70 84 90,30 80 86 

88 88 104,65 الموسم الرابع  × 100

104,65
= 84,08 

96 91,73 82 78,35 94 89,82 

 

 يتم تنفيذ هذه الطريقة وفقا للخطوات التالية:   :طريقة النسبة إلى الاتجاه العام- 2- 3

 إيجاد قيم الاتجاه العام باستخدام طريقة المربعات الصغرى. -

عي نقوم بطرح يمتجال  لنموذج الجدائي وحالة النموذج  قسمة القيم المشاهدة للسلسلة على القيم المقدرة في حالة ا-
 القيم الحقيقية من القيم المقدرة. 

حساب المعاملات الموسمية، حيث المعامل الموسمي لكل موسم يقابل متوسط المعاملات الموسمية لهذا الموسم في -
 كل سنة. 
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القيام بتصحيح المعاملات الموسمية إذا كان مجموعها يختلف عن طول الفترة إذا كانت السلسلة من الشكل -
 عي. يمجتالمن النموذج  الجدائي أو يختلف عن الصفر إذا كانت السلسلة  

 2024  - 2022لمؤسسة ما خلال الفترة    (CA)الجدول التالي يبين تطور قيم الفصلية لرقم أعمال :  12  مثال
 بالمليون دولار. 

 السنة      
 الموسم  

2022 2023 2024 

 8 4 3 الموسم الأول 

 12 8 5 الموسم الثاني 

 20 18 12 الموسم الثالث 

 25 26 20 الموسم الرابع 

 أوجد المعاملات الموسمية بطريقة النسبة إلى الإتجاه العام؟. 

 الحل:

 تحديد نوع السلسلة من خلال الشكل البياني:  .1

0

5

10

15

20

25

30

I II III IV I II III IV I II III IV

2022 2023 2024

CA
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 من خلال فحص الشكل أعلاه يتبين أن: 

 سلسلة رقم الأعمال يمكن كتابتها على شكل النموذج التجميعي لأن لها تغيرات ثابتة حول إتجاهها العام. -

 من خلال تطور قيم سلسلة يتبن وجود مركبة فصلية تظهر مرافقة للإتجاه العام للسلسة. -

 : تقدير قيم الإتجاه العام للسلسة .2

 :  (𝐶) وفي وجود الثابت   Tعلى الزمن    CAنقوم بتقدير إنحدار سلسلة رقم الأعمال  

𝐶𝐴𝑡 = 𝑇𝑡 + 𝐶 + 𝑒𝑡 

 ونتحصل على النموذج المقدر التالي:

 

 والذي يمكن كتابته كما يلي: 

𝑪𝑨̂𝒕 = 𝟏. 𝟑𝟕𝟒𝟏𝑻𝒕 + 𝟒. 𝟒𝟖𝟒𝟖 

 تأخذ القيم التالية:   𝐶𝐴̂𝑡بعد تقدير النموذج قيم المقدرة 

obs 𝐶𝐴𝑡 𝐶𝐴̂𝑡 
2022Q1 3 5.8589 
2022Q2 5 7.2331 
2022Q3 12 8.6072 
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2022Q4 20 9.9813 
2023Q1 4 11.3554 
2023Q2 8 12.7296 
2023Q3 18 14.1037 
2023Q4 26 15.4778 
2024Q1 8 16.8519 
2024Q2 12 18.2261 
2024Q3 20 19.6002 
2024Q4 25 20.9743 

عي يمتج بما أن السلسلة يمكن كتابتها من الشكل ال  :(Seasonal Indices (S)) حساب المعاملات الموسمية-
 ثل الفرق بين القيم الفعلية للسلسلة والقيم المقدرة لها وعليه تعطى في الجدول أدناه: تمفإن المعاملات الموسمية  

obs 𝑪𝑨𝒕 𝑪𝑨̂𝒕 𝑪𝑨𝒕 − 𝑪𝑨̂𝒕 
2022Q1 3 5.8589 -2.8589 

2022Q2 5 7.2331 -2.2331 

2022Q3 12 8.6072 3.3927 

2022Q4 20 9.9813 10.018 

2023Q1 4 11.3554 -7.3554 

2023Q2 8 12.7296 -4.7296 

2023Q3 18 14.1037 3.8962 

2023Q4 26 15.4778 10.5221 

2024Q1 8 16.8519 -8.8519 

2024Q2 12 18.2261 -6.2261 

2024Q3 20 19.6002 0.3997 

2024Q4 25 20.9743 4.0256 

 بعد ذلك نقوم بحساب المتوسط الحسابي لقيم كل فصل على مدار السنوات الثلاثة كما يلي:

𝑆𝑄1 =
−2,8589 − 7,3554 − 8,8519

3
= −6,3554 

𝑆𝑄2 =
−2,2331 − 4,7296 − 6,2261

3
= −4,3962 

𝑆𝑄3 =
3,3927 + 3,8962 + 0,3997

3
= 2,5628 
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𝑆𝑄4 =
10,018 + 10,5221 + 4,0256

3
= 8,1885 

 نقوم بجمع قيم المعاملات أعلاه نجد: 

∑ 𝑆𝑄𝑖
𝑖=4

𝑖=1
= 𝑆𝑄1 + 𝑆𝑄2 + 𝑆𝑄3 + 𝑆𝑄4 

∑ 𝑆𝑄𝑖
𝑖=4

𝑖=1
= −6,3554 − 4,3962 + 2,5628 + 8,1885 = 0,0003 

وعليه لا نقوم بتصحيح المعاملات الموسمية. وفي الحالة   نلاحظ أن مجموع قيم المعاملات الموسمية يساوي الصفر
 العكسية نقوم بتصحيح المعاملات الموسمية كما يلي:

𝑃 =
∑ 𝑆𝑄𝑖
𝑖=4
𝑖=1

4
⁄  

 ونجد قيم المعاملات الموسمية المصححة وفقا للعلاقة التالية: 

𝑆𝑄𝑖
′ = 𝑆𝑄𝑖 − 𝑃 

أسلوب إحصائي يهدف إلى إزالة   :(Seasonal Adjustment)  إزالة الأثر الموسمي من السلسلة الزمنية-4
تجرى هذه العملية للحصول على   .أو تقليل تأثير التغيرات الموسمية المنتظمة والمتكررة من بيانات السلسلة الزمنية

لا تظهر فيها التقلبات الدورية قصيرة المدى المرتبطة  (Seasonally Adjusted) "سلسلة زمنية "مُعدلة موسميا 

يتم إزالة التغيرات الموسمية من السلسلة الزمنية بقسمة قيم السلسلة ى ، أو الأيام(،ربع سنويبالمواسم )مثل الشهر،  

الأصلية على قيم المعاملات الموسمية إذا كانت السلسلة من الشكل الجدائي وطرح قيم المعاملات الموسمية من البيانات 
ا المحللين على يتساعد البيانات المعدلة موسمالأصلية للسلسة الزمنية إذا كانت هذه الأخيرة من الشكل التجميعي.  

يسهل تحديد ما إذا كان التغير في البيانات يمثل نموا  رؤية الأداء الحقيقي للظاهرة دون تشتيت التقلبات الموسمية، مما
كما تعد السلسلة الزمنية الخالية من الموسمية أكثر ملاءمة   .أو انخفاضا حقيقيا )اتجاه عام( أو مجرد تباين موسمي متوقع 

الدورية أولا التنبؤ بالاتجاه والعناصر  يتم  التنبؤ، حيث  التنبؤ لبناء نماذج  المتوقع إلى  ، ثم تعاد إضافة الأثر الموسمي 
 . (Reseasonalization)   إعادة التموسم النهائي
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 الخالية من الأثر الموسمي؟.   (CA)أوجد قيم السلسلة الزمنية لرقم الأعمال    12المثال  باستخدام معطيات    :13مثال  

 الحل:

مما سبق تبين أن سلسلة رقم الأعمال تأخذ الشكل التجميعي وعليه نقوم بطرح قيم المعاملات الموسمية من القيم 
𝐶𝐴𝑡)ثر الموسمي للحصول على سلسلة رقم الاعمال منزوعة الأ  (𝐶𝐴𝑡)الأصلية للسلسلة الزمنية 

 كما يلي:  (∗

 منزوعة الأثر الموسمي تعطى كما يلي:  2022من سنة    الفصل الأولقيمة السلسلة في  -

−𝑪𝑨𝑸𝟏𝟐𝟎𝟐𝟐
∗ = 𝐶𝐴𝑸𝟏𝟐𝟎𝟐𝟐 − 𝑆𝑄1 

𝑪𝑨𝑸𝟏𝟐𝟎𝟐𝟐
∗ = 𝟑 − (−6,3554) = 9,3554 

 منزوعة الأثر الموسمي تعطى كما يلي:  2022من سنة    الفصل الثانيقيمة السلسلة في  -

−𝑪𝑨𝑸𝟐𝟐𝟎𝟐𝟐
∗ = 𝐶𝐴𝑸𝟐𝟐𝟎𝟐𝟐 − 𝑆𝑄2 

𝑪𝑨𝑸𝟐𝟐𝟎𝟐𝟐
∗ = 𝟓 − (−4,3962) = 9,3962 

 منزوعة الأثر الموسمي تعطى كما يلي: 2022من سنة    الفصل الثالثقيمة السلسلة في  -

−𝑪𝑨𝑸𝟑𝟐𝟎𝟐𝟐
∗ = 𝐶𝐴𝑸𝟑𝟐𝟎𝟐𝟐 − 𝑆𝑄3 

𝑪𝑨𝑸𝟑𝟐𝟎𝟐𝟐
∗ = 12 + 2,5628 = 14,5628 

 منزوعة الأثر الموسمي تعطى كما يلي:  2022من سنة    الفصل الرابعقيمة السلسلة في  -

−𝑪𝑨𝑸𝟒𝟐𝟎𝟐𝟐
∗ = 𝐶𝐴𝑸𝟒𝟐𝟎𝟐𝟐 − 𝑆𝑄4 

𝑪𝑨𝑸𝟒𝟐𝟎𝟐𝟐
∗ = 20 + 8,1885 = 28,1885 

 وبنفس الطريقة نجد قيم باقي السلسة ونلخص كل ذلك في الجدول التالي: 
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 السنة      
 الموسم  

2022 2023 2024 

𝐶𝐴𝑡 𝑪𝑨𝒕
∗ 𝐶𝐴𝑡 𝑪𝑨𝒕

∗ 𝐶𝐴𝑡 𝑪𝑨𝒕
∗ 

Q1 3 9,3554 4 10,3554 8 14,3554 

Q2 5 9,3962 8 12,3962 12 16,3962 

Q3 12 14,5628 18 20,5628 20 22,5628 

Q4 20 28,1885 26 34,1885 25 33,1885 
 

 

وبعد ذلك   (𝐷̂𝑡+𝑘)  في المستقبل للحصول على  (𝐷𝑡)يتم التنبؤ بقيم السلسة الزمنية المعدلة موسميا  التنبؤ:  -5
ؤ  التنبقيمة  لكل فترة( إلى    (𝑆𝑖)  تعاد إضافة الأثر الموسمي المتوقع للفترة المستقبلية )باستخدام المعامل الموسمي المناسب

المعدلة. إذ نقوم بضرب القيم الاتجاهية في قيمة المعاملات الموسمية إذا كانت السلسة من الشكل الجدائي بينما في 
 حالة النموذج التجميعي نقوم بإضافة قيم المعاملات الموسمية للقيم الاتجاهية. 

 ؟. 2025أوجد القيم المتنبؤ بها لسنة    12المثال  باستخدام معطيات    :14مثال  

في   2025نقوم بحساب القيم الاتجاهية لسلسلة رقم الأعمال من خلال تعويض الفترات الزمنية الموسمية لسنة  -
 معادلة الاتجاه العام فنحصل على القيم التالية: 
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نقوم بإضافة قيم المعاملات الموسمية للقيم الاتجاهية   2025ولحساب قيم السلسة الزمنية للمواسم الأربعة في سنة  
 للسلسلة المتنبؤ بها ونلخص ما سبق في ما يلي: 

 السنة      
 الموسم  

2025 

𝑇  الاتجاهية القيم 𝑆𝑄1  القيم المتنبؤ بها 
Q12025 13 22.3484 −6,3554 15,993 

Q22025 14 23.7226 −4,3962 19,3264 

Q32025 15 25.0967 2,5628 27,6595 

Q42025 16 26.4708 8,1885 34,6593 
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 الملاحق 
 

 : جدول التوزيع الطبيعي01الملحق رقم  

 

 
Table pour les grandes valeurs de z 

 
Nota. La table donne F(z) pour Z positif. Pour Z négatif, il faut prendre le 

complément à l’unité de la valeur lue dans la table. Exemple : 

F(-1,37) = 1 - F(1,37) =1 - 0,9147 = 0,0853 
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 : جدول توزيع ستيودنت 02الملحق رقم  

 

 
Nota. V est le nombre de degrés de liberté. 

Le quantile d’ordre (1 − 𝛼/2) se lit dans la colonne 𝑃 = 𝛼 

Le quantile d’ordre (1 − 𝛼)  se lit dans la colonne 𝑃 = 2𝛼 
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𝜒2 𝐾ℎ𝑖(: جدول التوزيع كي دو03الملحق رقم   − 𝑑𝑒𝑢𝑥( 

 

 
Nota. V est le nombre de degrés de liberté. Pour V˃ 30, on peut admettre que la quantité 

√2𝜒2 − √2𝑉 − 1 suit la loi normale centrée réduite. 
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 : جدول توزيع فيشر 40الملحق رقم  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟎𝟓, 𝐯𝟏, 𝐯𝟐) 
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 : جدول توزيع فيشر40ملحق رقم  لل تابع  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟎𝟓, 𝐯𝟏, 𝐯𝟐) 
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 : جدول توزيع فيشر40ملحق رقم  لل تابع  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟏, 𝐯𝟏, 𝐯𝟐) 
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 : جدول توزيع فيشر40ملحق رقم  لل تابع  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟏, 𝐯𝟏, 𝐯𝟐) 
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 : جدول توزيع فيشر40ملحق رقم  لل تابع  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟎𝟏, 𝐯𝟏, 𝐯𝟐) 
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 : جدول توزيع فيشر40ملحق رقم  لل تابع  
𝐏(𝐗 ≥ 𝐚), 𝐗 ↝ 𝐅(𝟎, 𝟎𝟏, 𝐯𝟏, 𝐯𝟐) 
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  : جدول داربين واتسون05الملحق رقم  

 
 


